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Introduction

This chapter briefly describes the Timing Analyzer’s function, place
in the design flow, major features, inputs and outputs, and the
architectures with which it works. It also outlines the basic procedure
for using the tool.

Function
The Timing Analyzer performs a static timing analysis of a routed
FPGA design. A static timing analysis is a point-to-point analysis of a
design network. It does not include insertion of stimulus vectors.

The Timing Analyzer verifies that the delay along a given path or
paths meets your specified timing requirements. It organizes and
displays data that allows you to analyze the critical paths in your
circuit, the cycle time of the circuit, the delay along any specified
paths, and the paths with the greatest delay. It also provides a quick
analysis of the effect of different speed grades on the same design.

The Timing Analyzer works with synchronous systems composed of
flip-flops and combinatorial logic. In synchronous design, the Timing
Analyzer takes into account all path delays, including clock-to-Q and
setup requirements, while calculating the worse-case timing of the
design. However, the Timing Analyzer does not perform setup and
hold checks; you must use a simulation tool to perform these checks.

Design Flow
You use the Timing Analyzer after design entry, functional
simulation, mapping, placing, and routing, but before timing
simulation, as shown in Figure 1-1.
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Figure 1-1 Timing Analyzer in the Design Flow

Inputs and Outputs
The Timing Analyzer accepts an LCA file output by PPR or APR as
input and creates Xilinx report (XRP) files as output. It can also create
macro (XTM) files.

Architectures
You can use the Timing Analyzer with Xilinx XC2000, XC3000/A,
XC3100/A, XC4000/A/H/E, and XC5200 devices.

XDelay
The Timing Analyzer is similar to its predecessor, XDelay. However,
where XDelay was based on DOS or UNIX, the Timing Analyzer is
based on the Microsoft Windows graphical user interface.

If you used XDelay with a previous version of the Xilinx software,
refer to the “XDelay Command Equivalents” appendix, which lists

X6164
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Introduction
the XDelay commands and their corresponding Timing Analyzer
commands.

Features
The Timing Analyzer offers the following features.

Interface
You can issue Timing Analyzer commands from the menus, toolbar,
or Console window. You can also activate commands by running
macros. The instructions in this user guide use only the menu
commands or toolbar icons, but the equivalent command-line syntax
is given in the “Keyboard Commands” chapter.

Reports
The Timing Analyzer creates the following five reports.

● The Performance To TimeSpecs report indicates whether the
design meets the timing specifications entered using XACT-
Performance.

● The Performance Summary report displays the maximum clock
frequencies for all synchronous paths in the design and the worst-
case timing for all clocked paths. Synchronous paths include
clock-to-setup, clock-to-pad, pad-to-setup, pad-to-pad, and clock
input paths.

● The Detailed Path report displays a detailed analysis of all
specified paths and includes the worst-case path delays for all
paths in the design.

● The Check for Asynchronous Logic report contains the results of a
check that the Timing Analyzer performs on the LCA file for logic
that is not controlled by a register.

● The Show Clocks report lists the names of all clocks in the design.

The content of these reports is described in the “How to Use the
Timing Analyzer” chapter.
Timing Analyzer Reference/User Guide 1-3
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Path Filters
You can customize the Timing Analyzer reports by selecting certain
path filters in the Path Filters menu, which include or exclude specific
path types and/or nets. You can apply three types of filters.

● Timing specification filters report only those paths constrained by
timing specifications entered with XACT-Performance. These
filters apply to the Performance To TimeSpecs report.

● Path analysis filters report specific paths whose starting points,
ending points, and types you can define. These filters apply to the
Detailed Path report.

● Common filters can exclude or include specific nets, avoid tracing
false paths, and break combinatorial logic loops to treat them as
synchronous timing elements. Common filters apply to the
Performance to TimeSpecs, Performance Summary, and Detailed
Path reports.

Once the filters are set, you can generate reports for the specified
paths using the options under the Analyze menu.

Macros
You can create macros that run several Timing Analyzer commands
in one step. Macros are script files for running Timing Analyzer
commands and options. The Console window records all the
commands that you select in any Timing Analyzer session. After
entering the desired series of commands in this window, you can
copy and paste the sequence to a macro window, and save the macro.

Timing Analysis Procedure
The typical procedure for using the Timing Analyzer is as follows.

1. Open the Timing Analyzer and load a design.

2. If you are unfamiliar with the Timing Analyzer, explore its
features. You can use the Timing Analyzer tutorial to help you
with this process. To run the tutorial, select Help ➝ Tutorial .
1-4 Xilinx Development System
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3. You can optionally generate a report to obtain a basic overview of
the design’s timing before you begin to analyze it in detail. The
Performance Summary report is well-suited to this purpose.
Choose this report from the Analyze menu.

4. Select filters from the Path Filters menu to determine which types
of paths will be analyzed and reported. You can filter out paths
you are not interested in.

5. Select options from the Options menu to fine-tune the analysis.

6. Choose the kind of report you want from the Analyze menu.

7. Use the report window commands to view the report in more
detail, save the report, and print the report.

8. Optionally, you can create macros comprising the commands just
issued.

These steps are all described in the “How to Use the Timing
Analyzer” chapter. Steps 2, 3, 4, and 5 are optional.

Online Help
The Timing Analyzer offers both context-sensitive help and a Help
menu. See the “Getting Started” chapter for more information on the
online help available and instructions for accessing it.

Tutorial
An online tutorial demonstrating some of the Timing Analyzer’s
major functions is also available. For instructions on loading it on
your machine’s hard-disk drive, see the release notes accompanying
the software. To invoke the tutorial, click on Help ➝ Tutorial .

In addition, the “XACT-Performance and Timing Analyzer Tutorial”
chapter of the Viewlogic Tutorials manual demonstrates how to verify
path timing using the Timing Analyzer.
Timing Analyzer Reference/User Guide 1-5
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Timing Analysis

This chapter explains some of the concepts involved in static timing
analysis and how to use the Timing Analyzer to resolve key analysis
issues.

Basic Path Types
Once your design has been implemented, you can use the Timing
Analyzer to calculate your design’s system performance, which is
limited by five basic types of timing paths. Each of these paths goes
through a sequence of logic, routing, and logic. Since these path
delays are affected by the results of the placement and routing that
implement the design connectivity, these sequences can vary.

To prepare you to read the Timing Analyzer reports, the following
sections describe the basic path types in a design and discuss clock
skew.
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Clock to Setup
A clock-to-setup (C2S) path starts at the Q output of a flip-flop or
latch and ends at an input to another flip-flop, latch, or RAM, where
that pin has a setup requirement before a clocking signal. It includes
the clock-to-Q delay of a flip-flop, the path delay from that flip-flop to
the next flip-flop, and the setup requirement of the next flip-flop. The
clock-to-setup path time is the maximum time required for the data to
propagate through the source flip-flop, travel through the logic and
routing, and arrive at the destination before the next clock edge
occurs. Figure 2-1 shows a basic clock-to-setup path, along with a
timing diagram describing the path.

Figure 2-1 Clock-to-Setup Path (Same Clock)

Source and destination flip-flops can be clocked by the same clock on
different clock edges. In these cases, the path delay limits the
minimum clock high or clock low time, as seen in
Figure 2-2 and Figure 2-3.
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Figure 2-2 Clock-to-Setup Path (Rising to Falling Edge)
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Figure 2-3 Clock-to-Setup Path (Falling to Rising Edge)

If the source and destination are clocked by different clock nets, both
clock nets must have a clock period greater than the path delay. The
Timing Analyzer does not calculate the path delay between different
clock nets. Figure 2-4 shows a path of this type.
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Figure 2-4 Clock-to-Setup Path (Different Clocks)
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Clock to Pad
A clock-to-pad (C2P) path starts at the Q output of a flip-flop or latch
and ends at an output of the chip. It includes the clock-to-Q delay of
the flip-flop and the path delay from that flip-flop to the chip output.
The clock-to-pad path time is the maximum time required for the
data to leave the source flip-flop, travel through logic and routing,
and leave the chip. Figure 2-5 illustrates a clock-to-pad path.

Figure 2-5 Clock-to-Pad Path
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Pad to Setup
A pad-to-setup (P2S) path starts at an input of the chip and ends at an
input to a flip-flop, latch, or RAM — wherever there is a setup time
against a control signal. The pad-to-setup path time is the maximum
time required for the data to enter the chip, travel through logic and
routing, and arrive at the output before the clock or control signal
arrives. A pad-to setup path is shown in Figure 2-6.

Figure 2-6 Pad-to-Setup Path
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Pad to Pad
A pad-to-pad (P2P) path starts at an input of the chip and ends at an
output of the chip. The pad-to-pad path time is the maximum time
required for the data to enter the chip, travel through logic and
routing, and leave the chip. It is not controlled or affected by any
clock signal. A pad-to-pad path is displayed in Figure 2-7.

Figure 2-7 Pad-to-Pad Path

Clock Input
A clock input path starts at either an input of the chip or at the output
of a flip-flop, latch, or RAM. It ends at any clock pin on a flip-flip or
latch enable. The clock input path time is the maximum time required
for the signal to arrive at the flip-flop clock input. Clock input paths
help to determine system-level design timing. Figure 2-8 shows a
clock input path.

The clock input time is the maximum time only; the Timing Analyzer
does not currently calculate minimum clock times.
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Figure 2-8 Clock Input Path

Clock Skew
In the Timing Analyzer, clock skew is the difference in arrival time for
clocks that are on the same clock net. Clock skew occurs most often
when global routing is not used to route clock nets, since other
routing is less predictable. The arrival of clock signals at different
times can affect the required clock period.

When the destination is clocked before the source, the clock skew is
called negative clock skew. When the source is clocked first, the clock
skew is called positive clock skew. Negative clock skew means that
the clock period must be longer than the path delay plus the amount
of clock skew between the flip-flops. Positive clock skew means that
the clock period could be shorter than the path delay by the
minimum amount of clock skew. Because the Timing Analyzer does
not produce minimum numbers, this shortened clock period is
unreliable; do not depend on it. Figure 2-9 and Figure 2-10 illustrate
paths with negative and positive clock skew.
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Figure 2-9 Negative Clock Skew

interconnect

and

logic

X6194

D QD

clock



clock at FF1

clock at FF2

valid valid




Q

clock

to


output




logic and routing




delay

Flip-flop

setup

path delay

minimum clock period




FF1 FF2

clock skew
2-10 Xilinx Development System



Timing Analysis
Figure 2-10 Positive Clock Skew

Design Analysis Issues
The Timing Analyzer can help you resolve some of the most
frequently encountered design problems. This section describes these
solutions.

Feedback Loops
Asynchronous feedback paths in a design can cause many paths to be
reported that may not actually be timing problems. The most
common cases are feedback paths through asynchronous Set or Reset
to banks of flip-flops, like a state machine or a counter. Another
example is the construction of latches from function generators,
which are built using asynchronous feedback paths. When you use
the Break Logic Loops command, the Timing Analyzer can treat
latches built from combinatorial logic like synchronous points, so that
paths stop and start at these points but do not go through them.
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To exclude specific nets that create feedback paths, such as an illegal-
state Reset logic loop for a state machine, you can use the Exclude
Paths With Nets command. It excludes from the timing report any
paths that contain those nets.

With the Control Possible False Paths command, you can control
some asynchronous points through logic; for example, you can
exclude the asynchronous Reset of a flip-flop or bidirectional I/O.

Timing Specifications
If you entered timing constraints before compiling your design with
PPR, you can use the Timing Analyzer to verify whether your
constraints were met. Figure 2-11 shows how the Timing Analyzer
finds a path that did not meet the timing specification.

Figure 2-11 Failed Timing Specification
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Asynchronous Logic
The Check for Asynchronous Logic command creates a report
showing all of the asynchronous logic feedback loops in your design.
These loops can cause design problems or create false timing paths.
The “Feedback Loops” section of this chapter discusses some of the
ways that you can correct feedback loops.

Clock Skew
The Timing Analyzer can report clock skew, which is the difference
between the time a clock signal arrives at the source flip-flop in a path
and the time it arrives at the destination flip-flop. Normally clock
skew does not arise if you use global clock routing for all the clocks in
a design. As the report in Figure 2-12 demonstrates, the Performance
To TimeSpecs command generates a report that displays the clock
skew for individual paths starting and ending at flip-flops on the
same clock net.

Figure 2-12 Clock Skew on Performance To TimeSpecs Report
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You can use the Options ➝ Query ➝ Nets command to see the clock
skew across specific clock nets. Figure 2-13 gives an example for the
CLK1 and CLK2 nets.

Figure 2-13 Clock Skew on Query Nets Report

Off-Chip Delay
To determine system-level clock speed, you must add any external
delay to paths that travel off-chip. This way, the Timing Analyzer
includes this external delay when calculating the delay for the path.
You can assign input/output delay margin values to the pad-to-setup
and clock-to-pad path types with the Set Delay Margins for I/O
command. There is no default delay; the Timing Analyzer does not
add off-chip delay unless you specify it with this command.
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Getting Started

This chapter describes how to access and exit the Timing Analyzer;
how to use its menus, icons, Console window, dialog boxes, and
filters; and how to use its online help facility.

Invoking the Timing Analyzer
You can invoke the Timing Analyzer from either the Windows
Program Manager or the Design Manager.

From the Windows Program Manager
To invoke the Timing Analyzer from the Windows Program Manager,
click on the Timing Analyzer icon, shown in Figure 3-1.

Figure 3-1 Timing Analyzer Icon

From the Design Manager
To invoke the Timing Analyzer from the Design Manager window,
click on the Timing Analyzer icon, which is the same as that shown in
Figure 3-1, or click on the Tools ➝ Timing Analyzer  menu
command.
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Exiting the Timing Analyzer
To exit the Timing Analyzer, select File ➝ Exit .

If you have unsaved reports open, a prompt box similar to that in
Figure 3-2 appears:

Figure 3-2 Exit Prompt Box

Click on Yes  to save the report, then follow the procedure described
in the “Saving a Report” section of the “How to Use the Timing
Analyzer” chapter.

Navigating in the Timing Analyzer
This section describes the Timing Analyzer’s main window, its
Console window, and its menus and dialog boxes.

Timing Analyzer Window
When you invoke the Timing Analyzer, the Timing Analyzer window
appears, as illustrated in Figure 3-3.
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Figure 3-3 Timing Analyzer Window

By default, the toolbar appears at the top of the window, and the
status bar appears at the bottom of the window; however, you can
hide them from view by selecting the Toolbar or Status Bar
commands, respectively, on the View menu. When you move the
cursor over a menu command or select a menu command, a brief
description of the command’s function appears in the status bar. As
the Timing Analyzer processes, status messages also appear in the
status bar.

You can access Timing Analyzer commands from the menus, toolbar,
or Console window.

Menus
All of the Timing Analyzer commands are available on the graphical
interface menus. However, most of the commands are grayed out and
therefore unavailable unless a design is loaded.

You can select menu commands with the mouse or the keyboard.
With the mouse, click the left mouse button on the desired command.

Menu bar
Toolbar

Status
bar
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With the keyboard, press the Alt key and type in the letter underlined
in the command.

When you select a menu command with either method, a brief
description of the command’s function appears in the status bar at the
bottom of the Timing Analyzer window.

For complete command descriptions, select the Contents command
from the Help menu or see the “Menu Commands” chapter of this
manual.

Toolbar Icons
You can access some of the Timing Analyzer commands through
toolbar icons. These icons are listed and described in the “Menu
Commands” chapter of this manual. When you move the cursor over
each icon, an identifying label appears.

Console Window
The Console window records the sequence of commands that you
have used in a Timing Analyzer session. It offers a command line
where you can enter Timing Analyzer commands, but it is basically
used for creating macros. For information on creating and using
macros, see the “How to Use the Timing Analyzer” chapter of this
manual.

The commands that you can enter in the Console window are
described in the “Keyboard Commands” chapter.

You can open a Console window by selecting View ➝ Console.

Dialog Boxes
An ellipsis (...) following a Timing Analyzer menu command
indicates that the command activates a dialog box in which you can
enter information and set options.

Common Fields in Dialog Boxes

The following fields are common to many of the Timing Analyzer
dialog boxes.
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● OK closes the dialog box and implements the intended action
according to the settings in the dialog box.

● Cancel closes the dialog box without effecting any action.

● Help gives you information on how to use the dialog box.

Selecting Objects in Dialog Boxes

Many of the dialog boxes in the Timing Analyzer feature list boxes,
such as those shown under “Available Nets” and “Selected Nets” in
Figure 3-4. You can move items from one list box to another using
either the mouse or the keyboard, or a combination of these methods.

Figure 3-4 List Boxes in Dialog Box

Using the Mouse

Using the mouse, you can select items in list boxes with the following
methods.

● To select one object, select the object with the left mouse button.
Click on the Add (>) button.
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● To select all objects, click on the Add All (>>) button.

● To select multiple objects in a row, select the first object with the
left mouse button. Hold down the Shift key. Select the last object
and release the Shift key. Click on the Add (>) button.

You can also drag the cursor up or down until all the appropriate
objects are highlighted and then click the Add (>) button.

● To select multiple objects in any order, hold down the Control key
while clicking on individual objects. When you are finished
selecting objects, release the Control key and click on the Add (>)
button.

Using the Keyboard

Using the keyboard, you can select items in list boxes with the
following methods.

Note: The Return key is the same as the Enter key in the following
procedures.

● To select one object, press the Tab key until the first item in the list
box is underlined. Use the down arrow key to select the desired
item. Tab to the Add (>) button. Press the Return key.

● To select all objects, tab to the Add All (>>) arrow and press the
Return key.

● To select multiple objects in a row, tab to the first line in the list
box. Use the down arrow key to move to the first object. Press and
hold the Shift key while using the down arrow key to select the
other objects in the row. Tab to the Add (>) button. Press the
Return key.

● To select multiple objects in any order, tab to the list box and press
Shift F8. Use the up and down arrow keys to navigate within the
list box. Press the space bar to select each item. Tab to the Add (>)
button. Press the Return key.

To tab from right to left, press the Shift key, then press the Tab key.

To scroll down the list box to select items that are not visible in the list
box, tab to the list box and click on the Pg Dn key.
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You can select options in a dialog box by pressing Alt and typing the
character underlined in the option.

Pressing the Escape key closes the dialog box.

Using Filters in Dialog Boxes

Many of the commands in the Timing Analyzer allow you to filter a
list of choices, that is, to display a subset of the listed items. The
dialog boxes associated with these commands contain a filter area,
such as the space below “Filter for Available Nets” in Figure 3-4. In
this space, you enter a text string consisting of characters and
wildcards.

Characters can be any alphanumeric characters, text spaces, and the
characters that appear on the top of the number keys on a normal
keyboard. Alphabetic characters are case-sensitive. No control
characters are permitted.

A wildcard can be an asterisk (*), which can represent any number of
characters, or a question mark (?), which represents a single
character.

You cannot enter a range of items in the filter space.

The Timing Analyzer does not strictly match patterns; it does not find
the desired string if it is embedded in a larger string. For example, it
does not find $1N36 if it is embedded in ABC$1N36XYZ. However, if
you searched for *$1N36*, it would find the desired string in
ABC$1N36XYZ.

After typing in the filter information, click on Apply  or press the
Return key to apply the filter.

To clear the filter, click on Clear  or backspace over the information
in the filter text box.

Following is an example showing you how to use filters.
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The Path Filters ➝ Common Filters ➝ Include Paths With Nets
command selects the nets to be analyzed. It brings up the Include
Paths With Nets dialog box, shown in Figure 3-5. All the elements of
the design are included in the Excluded Nets list box.

Figure 3-5 Original Include Paths With Nets Dialog Box
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Because the number of nets in the design can be cumbersome, a filter,
$2N*, is applied to reduce the number of elements in the Excluded
Nets list box, as indicated in Figure 3-6. Only the elements whose
names begin with $2N now appear in this list box.

Figure 3-6 Specifying the Filter
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Finally, only elements $2N350 through $2N399 are of interest in this
analysis, so they are moved to the Included Nets list box, as
illustrated in Figure 3-7.

Figure 3-7 Elements Included in Analysis

Obtaining Help
You can obtain help on the Timing Analyzer’s commands and
procedures by selecting commands on the Help menu or by selecting
the Help icon in the toolbar. In addition, the dialog boxes associated
with some commands offer a Help button that you can click on to
obtain context-sensitive help.

Help Menu
The Help menu displays the following commands.

● The Contents command lists the online help topics available for
the Timing Analyzer. From the opening screen, you can jump to
command information or step-by-step instructions for using the
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Timing Analyzer. Once you open help, you can click the Contents
button (first button on the left) in the Help window whenever you
want to return to the help topic list.

Pressing the F1 key is the same as selecting the Contents
command.

● The Search for Help On command brings up a pop-up window
that lets you search for a specific topic.

● The Tutorial command activates an interactive tutorial
demonstrating some of the procedures available in the Timing
Analyzer.

● The About Timing Analyzer command brings up a pop-up
window that displays the version number of the Timing Analyzer
software.

Toolbar Icon
You can obtain context-sensitive help from the toolbar.

1. Click on the Help icon from the toolbar, shown in Figure 3-8:

Figure 3-8 Help Icon

The cursor changes to a question mark.

2. Click once with the left mouse button on the menu item or toolbar
icon for which you want information.

The Timing Analyzer displays information about the selected
command or option in a pop-up window.

Help Button in Dialog Boxes
Many of the dialog boxes in the Timing Analyzer offer a Help button,
such as that shown in in the lower right corner of Figure 3-9, that you
can click on to obtain help on that dialog box. A window opens that
gives you information.
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Figure 3-9 Help Field on Dialog Box
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How to Use the Timing Analyzer

This chapter describes all the functions that you can perform with the
Timing Analyzer.

Note: The commands and dialog boxes in this chapter are used in the
context of procedures, but they are not explained in detail. For a
detailed explanation of them, see the “Menu Commands” chapter.

Opening a Design
Before you can create a timing report using the Timing Analyzer, you
must load a routed LCA design file. To open a design for timing
analysis, follow these steps.

1. Select File �➝ Open, or double-click on the Open Design File
toolbar icon, shown in Figure 4-1.

Figure 4-1 Open Design File Icon

The Open Design/Report File dialog box appears, as shown in
Figure 4-2.
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Figure 4-2 Open Design/Report File Dialog Box

2. In the Drives field, select the name of the drive containing the
LCA file to load.

3. In the Directories list box, click on the directory containing the
LCA file to load.

4. Make sure that Design File is displayed in the List Files of Type
box; if not, select it.

All the available LCA files are now displayed in the list box.

5. Select a placed and routed LCA file from the list box, or type it in
the space below File Name after backspacing over the asterisk.

6. Click on OK.

The Timing Analyzer reads the die and package files, reads the
design, processes any timing specifications, and then loads the
design. It displays a progress meter that charts the progress for
each step. When the design is loaded, a dialog box appears with
the following message:

Design is loaded successfully

You can now create a timing report. Refer to the next section,
“Creating a Report,” for instructions on this procedure.
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Warning: If you load a different design, the Timing Analyzer resets
the current settings to the defaults.

Creating a Report
Once you load the LCA design file, you can decide what kind of
report you want to generate. This section describes how to create all
the reports available in the Timing Analyzer as well as how to save
and print them.

With the Find command on the Analyze menu, you can search for
specific text strings in the reports. Directions for this procedure are
given in the “Searching for Text in a Report” section later in this
chapter.

The Timing Analyzer has default settings that you can change using
path filters. Path filters narrow the scope of the report by selecting
which paths you want to analyze. For more information, refer to the
“Filtering Paths” section of this chapter. To view the default settings,
refer to the “Viewing Timing Analyzer Settings” section towards the
end of this chapter.

Creating a Performance To TimeSpecs Report
The Performance To TimeSpecs report compares the design’s
performance to the timing specifications entered using XACT-
Performance.

Select Analyze ➝ Performance To TimeSpecs , or double-click
on the Performance To TimeSpec icon in the toolbar, shown in Figure
4-3.

Figure 4-3 Performance To TimeSpec Icon

After processing the design, the Timing Analyzer displays the timing
report in a pop-up window, as shown in Figure 4-4.
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Figure 4-4 Performance To TimeSpecs Report

You can use the following path filters to narrow the scope of this
report:

● Report Paths Failing TimeSpec

● Report Paths With No TimeSpec

● Ignore TimeSpecs

● Include Paths With Nets

● Exclude Paths With Nets

● Control Possible False Paths

● Break Logic Loops
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Creating a Performance Summary Report
The Performance Summary report displays the maximum clock
frequencies for all clocks in the design and the worst-case timing for
all clock paths.

Select Analyze ➝ Performance Summary , or double-click on the
Design Performance Summary icon in the toolbar, shown in
Figure 4-5.

Figure 4-5 Design Performance Summary Icon

After processing the design, the Timing Analyzer displays the
Performance Summary report in a pop-up window. It is shown in
Figure 4-6.
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Figure 4-6 Performance Summary Report

You can use the following path filters to narrow the scope of this
report:

● Select Sources

● Select Destinations

● Select Path Types

● Include Paths With Nets

● Exclude Paths With Nets

● Control Possible False Paths

● Break Logic Loops
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Creating a Detailed Path Report
The Detailed Path report displays a detailed analysis of all specified
paths. It contains the worst-case path delays for all paths in the
design.

Select Analyze ➝ Detailed Path Report , or double-click on the
Detailed Analysis icon in the toolbar, shown in Figure 4-7.

Figure 4-7 Detailed Analysis Icon

After processing the design, the Timing Analyzer displays the
Detailed Path report in a pop-up window, as Figure 4-8 illustrates.
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Figure 4-8 Detailed Path Report

You can use the following path filters to narrow the scope of this
report:

● Select Sources

● Select Destinations

● Select Path Types

● Include Paths With Nets

● Exclude Paths With Nets

● Control Possible False Paths

● Break Logic Loops
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Creating a Check for Asynchronous Logic Report
The Check for Asynchronous Logic command checks the LCA file for
logic that is not controlled by a register. It issues the results in the
Check for Asynchronous Logic report.

Select Analyze ➝ Check for Asynchronous Logic .

After processing the design, the system displays the report in a
secondary window, as shown in Figure 4-9.

Figure 4-9 Check for Asynchronous Logic Report

Creating a Show Clocks Report
The Show Clocks command creates a report that lists the names of all
clocks in the design.

Select Analyze ➝ Show Clocks .

After processing the design, the system displays the clock names in a
secondary window. An example of the Show Clocks report is given in
Figure 4-10.
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Figure 4-10 Show Clocks Report

Searching for Text in a Report
You can use the Find command to search for any text string in the
active report window, including normal grammatical symbols like
hyphens or underscores. You cannot search for special characters like
tabs or hard returns, however.

To search for a text string in a report, do the following.

1. Open or select the report window in which you want to search.

2. Select Analyze ➝ Find .

The Find dialog box appears, as shown in Figure 4-11.

Figure 4-11 Find Dialog Box
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3. Enter the text string that you want to search for in the Find What
box.

You can also select either of the following options.

● Match Case finds only instances that have the same case as the
text string. By default, it ignores the case of the text.

● Match Whole Word finds only instances of the text string that
are whole words, not part of a larger word. By default, it finds
any instance of the text string, whether the instance is
embedded in another word or not.

4. Indicate the search direction.

● Up searches backward from the present location of the cursor
to the beginning of the report. It stops at the beginning of the
report.

● Down searches forward from the present location of the cursor
to the end of the report. It stops at the end of the report. This
direction is the default.

5. Click the Find Next  button to find the next instance of the text
string.

6. Click on Cancel  to close the Find dialog box.

Customizing a Report
You can determine the appearance and the content of the reports that
the Timing Analyzer generates.

To change the report options, select Options ➝ Report Options .

The Timing Analyzer displays the Report Options dialog box, shown
in Figure 4-12, which contains the following options.
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Figure 4-12 Report Options Dialog Box

Setting the Maximum Number of Paths

By default, the Timing Analyzer analyzes all paths. To limit the total
number of paths that the Timing Analyzer reports, select Maximum
Number of Paths , and enter a value in the box. Values can be
between 0 and 999, inclusive. The Timing Analyzer uses the criterion
set in the Sort By field to select the paths to report.

You can use this option with the Detailed Path report. For example, if
you enter 10 in the Maximum Number of Paths field and set the Sort
By option to Descending Delay, the Timing Analyzer reports the 10
paths with the longest delay.

This option can be useful when system memory is limited because it
limits the number of paths stored in memory.
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Reporting Delays Less Than a Value

By default, the Timing Analyzer reports all paths regardless of their
delay, but you can instruct the Timing Analyzer to report only those
paths that have a delay less than or equal to the specified value. To do
so, select Report Delays Less Than , and enter a value, in
nanoseconds, in the box.

Reporting Delays Greater Than a Value

By default, the Timing Analyzer reports all paths regardless of their
delay, but you can instruct the Timing Analyzer to report only those
paths that have a delay greater than or equal to the specified value.
To do so, select Report Delays Greater Than , and enter a value,
in nanoseconds, in the box.

Setting Path Report Order

You can define the order in which the Timing Analyzer reports the
paths. In the Sort By  field, select one of the following six options.

● Ascending Delay lists paths in order from shortest to longest
delays.

● Descending Delay, the default, lists paths in order from longest to
shortest delays.

● Source Block sorts path delays by the source block name, which is
useful when trying to determine the worst-case delay from a
given block.

● Destination Block sorts path delays by the destination block name,
which can help determine the worst-case path to each block.

● Source Clock Net sorts path delays by the clock name that sources
the first element in a path, which separates delay information for
two or more clock nets in a design.

● Destination Clock Net sorts path delays by the clock name that
sources the last element in a path.

Reporting Only Longest Paths Between Points

By default, the Timing Analyzer reports all paths. However, if there is
more than one path between two end points, you can direct the
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Timing Analyzer to report only the path with the longest delay. Select
the Report Only Longest Paths Between Points  check box.

Setting Report Format

The Timing Analyzer contains three report output options as follows.
The default is Normal Report. Click on the option button or adjacent
text to select the report output format.

● Short Report generates a report containing only the path source
and end point. This report lists one delay path per line and does
not display cumulative delays through CLBs.

● Wide Report creates a report formatted into 132 characters per
line, which prevents long block and net names from being
truncated.

● Normal Report, the default, produces a report displaying a
detailed list of path delays.

Printing a Report
You can send a Timing Analyzer report to your default printer, or you
can send it to a printer that you specify.

Sending a Report to the Default Printer

To send any report to the default printer, follow these instructions.

1. Select File ➝ Print , or click on the Print Report icon, shown in
Figure 4-13.

Figure 4-13 Print Report Icon

The Timing Analyzer displays the Print dialog box, illustrated in
Figure 4-14, which indicates the default printer.

Note: When you invoke this command from the toolbar, the system
does not display the Print dialog box. It sends one copy to the default
printer.
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Figure 4-14 Print Dialog Box

2. If you want to print more than one copy, enter the number of
copies that you want to print.

3. Select OK.

Sending a Report to an Alternate Printer

To send any report to a printer other than the default printer for your
site, select File ➝ Printer Setup .

The Print Setup dialog box appears, as shown in Figure 4-15. Follow
the instructions in the Microsoft Windows documentation to set any
of the options in this dialog box.
Timing Analyzer Reference/User Guide 4-15



Timing Analyzer Reference/User Guide
Figure 4-15 Print Setup Dialog Box

Saving a Report
Follow this procedure to save a report.

1. Make sure the report that you want to save is in the active
window.

2. Click on File ➝ Save Report , or select the Save Report icon,
shown in Figure 4-16.

Figure 4-16 Save Report Icon

The Timing Analyzer displays the Save Report dialog box,
illustrated in Figure 4-17.
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Figure 4-17 Save Report Dialog Box

3. In the Drives field, select the drive in which you want to save the
report.

4. In the Directories list box, select the directory in which you want
to save the report.

5. In the File Name field, backspace over the asterisk and type in the
name of the file in which to store the report. By default, if you do
not specify a file extension, the Timing Analyzer saves the file as
an XRP file, that is, as a file with an .xrp extension.

If you want to overwrite an existing file with the new report, click
on the Save File as Type field to select a category of file type to
display in the File Name list box, then click on the name of the
existing file in the list box.

You can also use word processor applications such as MS-Word or
Notepad to open and edit the report file.

6. Click on OK.

The Save Report dialog box closes.
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Closing a Report
To close a report, do one of the following.

● Select File ➝ Close Report .

The report closes.

● Double-click on the bar in the upper left-hand corner of the report
pop-up window.

The following prompt appears:

Figure 4-18 Save Prompt Box

Click on Yes  to save the report window.

Opening a Saved Report
You can open a previously saved report to view or print by following
these steps.

1. Click on File ➝ Open.

The Open Design/Report File dialog box appears, as shown in
Figure 4-19.
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Figure 4-19 Open Design/Report File Dialog Box

2. In the Drives field, select the name of the drive containing the
report file to load.

3. In the Directories list box, click on the directory containing the
report file to load.

4. In the List Files of Type box, select Report File .

All the available report files are now displayed in the list box.

5. Select a report file from the list box, or type it in the space below
File Name after backspacing over the asterisk. If you do not
specify a file extension, the Timing Analyzer loads an XRP file by
default.

6. Click on OK.

Filtering Paths
By default, the Timing Analyzer reports the path delays for all paths
in the design. The Path Filters menu contains commands that enable
you to select a subset of paths for analysis. It consists of three
submenus: TimeSpec Filters, Path Analysis Filters, and Common
Filters. These filters are described in the “Introduction” chapter.
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Once the filters are set, you can generate reports for the specified
paths using the options under the Analyze menu. Refer to the
Creating a Report” section for more information on report generation.

You can select more than one filter from same filter menu.

The procedures in the following sections often direct you to specify a
filter in in a dialog box or to move items in a dialog box. Refer to the
“Using Filters in Dialog Boxes” section of the “Getting Started”
chapter for instructions on specifying a filter. For information on
selecting and moving items in dialog boxes, refer to the “Selecting
Objects in Dialog Boxes” section in the “Getting Started” chapter.

The following sections describe the filters that you can set to narrow
the scope of the analysis.

Filtering Designs with Timing Specifications
If your design contains XACT-Performance timing specifications, you
can choose any of the following commands to narrow the scope of the
information specified in the Performance To TimeSpecs report. These
options do not alter the Performance Summary report or the Detailed
Path report.

Reporting Paths That Do Not Meet Timing
Specifications

You can instruct the Timing Analyzer to generate a report containing
only the paths that do not meet your timing specifications. Follow
these steps:

1. Select Path Filters ➝ TimeSpec Filters ➝ Report Paths
Failing TimeSpec .

A check mark appears to the left of the menu item to indicate that
the item is selected.

2. Create a Performance To TimeSpecs report, as described earlier in
this chapter, or select additional path filters.

Reporting Paths with No Timing Specifications

You can restrict the Timing Analyzer to reporting only those paths
without timing specifications. Use the following procedure.
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1. Select Path Filters ➝ TimeSpec Filters ➝ Report Paths
With No TimeSpec .

A check mark appears to the left to indicate that the item is
selected.

2. Create a Performance To TimeSpecs report, as described in this
chapter, or select additional path filters.

PPR automatically assigns timing specifications to paths that do not
have user-assigned timing specifications, but the Timing Analyzer
ignores them when it generates its reports.

Ignoring Timing Specifications

To prevent the Timing Analyzer from analyzing the specified timing
specifications, perform the following steps.

1. Select Path Filters ➝ TimeSpec Filters ➝ Ignore
TimeSpecs .

The Ignore TimeSpecs dialog box appears, as shown in
Figure 4-20.

Figure 4-20 Ignore TimeSpecs Dialog Box
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2. Enter a filter in the Filter for Selected TimeSpecs field to display a
subset of timing specifications, if desired, and click on Apply .

The subset of timing specifications is displayed in the Selected
TimeSpecs list box.

3. Move the timing specifications that you want to exclude from the
Performance To TimeSpecs report to the Ignored TimeSpecs list
box.

4. Click on OK.

The Ignore TimeSpecs dialog box closes. You can now select
another filter or generate a Performance To TimeSpecs report.

Limiting Number of Paths Per Timing Specification

You can limit the number of paths reported per timing specification.
However, you can only set this limit in the Console window, not with
a menu command.

1. Click on View ➝ Console .

2. In the bar at the bottom of the Console window, type in the
following:

MaxNoPathsPerTimespec number_of_paths

3. Run a Performance To TimeSpecs report.

You can also use the MaxNoPathsPerTimespec command in a macro.

Selecting Sources and Destinations
You can select the starting points and ending points for path analysis
by selecting the Select Sources or Select Destinations filter on the Path
Analysis Filters menu, as described in the following sections. By
default, the Timing Analyzer selects all sources and all destinations
for path analysis.

Once you select sources or destinations to include, you can generate a
Detailed Path report.

Selecting Sources

Sources can be flip-flops, IOBs, clocks, nets, pins, CLBs, or all types.
To select specific sources for path analysis, follow these steps.
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1. Select Path Filters ➝ Path Analysis Filters ➝ Select
Sources .

The Select Sources dialog box appears, as shown in Figure 4-21.

Figure 4-21 Select Sources Dialog Box

2. In the box in the upper left-hand corner, select the starting point
type by clicking on the down arrow to display the list of options:
Flip-Flops, IOBs, Clocks, Nets, Pins, CLBs, or All. The default is
Flip-Flops.

3. If you selected Clocks, indicate in the Edge field whether the
source is a clock’s rising edge, falling edge, or either edge.

4. Enter a filter in the Filter for Available Sources field to display a
subset of the specified source type, if desired, and click on Apply .

5. Highlight All Sources and remove it from the Selected Sources list
box by pressing the Remove (<) button.
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6. Select the sources that you want to include in your timing analysis
by using the Add (>) button to move them from the Available
Sources list box to the Selected Sources list box.

7. Repeat steps 2 through 6 until you have moved all the desired
elements to the Selected Sources list box.

8. Click on OK.

The Select Sources dialog box closes. You can now select another
filtering command or generate a timing report.

Selecting Destinations

Destinations can be flip-flops, IOBs, clocks, nets, pins, CLBs, or all
types. To select specific destinations, follow these instructions.

1. Select Path Filters ➝ Path Analysis Filters ➝ Select
Destinations .

The Select Destinations dialog box comes up, as Figure 4-22
illustrates.
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Figure 4-22 Select Destinations Dialog Box

2. In the box in the upper left-hand corner, select the ending point
type by clicking on the down arrow to display the list of options:
Flip-Flops, IOBs, Clocks, Nets, Pins, CLBs, or All. The default is
Flip-Flops.

3. If you selected Clocks, indicate in the Edge field whether the
destination is a clock’s rising edge, falling edge, or either edge.

4. Enter a filter in the Filter for Available Destinations field to
display a subset of the specified destination type, if desired, and
click on Apply .

5. Highlight All Destinations and remove it from the Selected
Destinations list box by pressing the Remove (<) button.

6. Select the end points that you want to include in your timing
analysis by moving them from the Available Destinations list box
to the Selected Destinations list box.
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7. Repeat steps 2 through 6 until you have moved all the desired
elements to the Selected Destinations list box.

8. Click on OK.

The Select Destinations dialog box closes. You can now select
another filtering command or generate a timing report.

Selecting Specific Path Types
By default, the Timing Analyzer analyzes all path types; however,
you can restrict the types of paths that it reports. For more
information on the five basic path types, refer to the “Basic Path
Types” section of the “Timing Analysis” chapter.

Once you select the path types to analyze, you can generate a
Detailed Path report or a Performance Summary report.

Use this procedure to select specific path types for analysis.

1. Click on Path Filters ➝ Path Analysis Filters ➝
Select Path Types .

The Timing Analyzer displays the Select Path Types dialog box, as
shown in Figure 4-23

Figure 4-23 Select Path Types Dialog Box
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You can select the following path types:

● Clock To Setup reports clock-to-setup paths.

● Clock To Pad reports clock-to-pad paths.

● Pad To Setup reports pad-to-setup paths.

● Paths Ending At Clock Pin of Flip-flop reports clock input
paths.

● Pad To Pad reports pad-to-pad paths.

By default, all path types are selected.

2. Deselect any path types that you do not want to analyze by
clicking on them with the left mouse button or entering the
underlined letter that represents that option.

Note: Click on an object to reselect it.

3. Press OK.

The Select Path Types dialog box closes. You can now select
another filtering command or generate a Performance Summary
report or a Detailed Path report.

Including and Excluding Paths with Nets
You can include or exclude paths with nets by selecting the Include
Paths With Nets or Exclude Paths With Nets commands, as described
in the following sections.

Although the two filters appear to be similar, they are not mutually
exclusive. For example, you may want to exclude any path that goes
through the synchronous Reset net of the counter but include all
paths that go through bit 1 of the counter. This way, you can include
or exclude specific nets that are attached to the counter.

Once you select which paths with nets to include or exclude, you can
generate the Performance To TimeSpecs, Performance Summary, or
Detailed Path reports.

Including Paths with Nets

With the Include Paths With Nets command, you can select specific
nets to be analyzed.
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1. Select Path Filters ➝ Common Filters ➝ Include Paths
With Nets .

The Include Paths With Nets dialog box appears, as shown in
Figure 4-24.

Figure 4-24 Include Paths With Nets Dialog Box

2. Enter a filter in the Filter for Excluded Nets field to display a
subset of included nets, if desired, and click on Apply .

3. Select the nets that you want to include in your timing analysis by
moving them from the Excluded Nets list box to the Included Nets
list box.

4. Click on OK.

The Include Paths With Nets dialog box closes. You can now select
another filtering command or generate any timing report.
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Excluding Paths with Nets

The Exclude Paths With Nets command enables you to exclude
specific nets from the timing analysis.

1. Select Path Filters ➝ Common Filters ➝ Exclude Paths
With Nets .

The Exclude Paths With Nets dialog box comes up, as
demonstrated in Figure 4-25.

Figure 4-25 Exclude Paths With Nets Dialog Box

2. Enter a filter in the Filter for Included Nets field to display a
subset of included nets, if desired, and click on Apply .

3. Select the nets that you want to exclude in your timing analysis by
moving them from the Included Nets list box to the Excluded
Nets list box.

4. Click on OK.
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The Exclude Paths With Nets dialog box closes. You can now
select another filtering command or generate any timing report.

Controlling Possible False Paths
You can prevent the Timing Analyzer from tracing false paths
through RAM, 3-state buffers, input and output pins, and Set/Reset
logic.

Once you select the false paths to control, you can generate the
Performance To TimeSpecs, Performance Summary, or Detailed Path
report.

1. Select Path Filters ➝ Common Filters ➝ Control
Possible False Paths .

The Timing Analyzer displays the Control Possible False Paths
dialog box, illustrated in Figure 4-26.

Figure 4-26 Control Possible False Paths Dialog Box
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2. Select the block type that you want to control in the Paths
Through field; the following types are available.

● Data Input of CLB RAM allows or prohibits paths through the
data inputs of a CLB RAM. By default, the Timing Analyzer
prohibits these paths.

● Write Enable of CLB RAM allows or prohibits paths through
the write-enable input of a CLB RAM. By default, the Timing
Analyzer prohibits these paths.

● Tristate to Output Pin of BUFT allows or prohibits paths that
go through a BUFT T pin to the BUFT O pin. By default, the
Timing Analyzer allows these paths.

● Input Pin to Output Pin of BUFT allows or prohibits paths that
go through the BUFT I pin to the BUFT O pin. By default, the
Timing Analyzer allows these paths.

● Output Pin to Input Pin of IOB allows or prohibits paths that
go from the IOB O pin to the pad and back into the chip
through the IOB I pin. By default, the Timing Analyzer
prohibits these paths.

● Tristate Pin to Input Pin of IOB allows or prohibits paths that
go from the IOB T pin to the pad and back into the chip
through the IOB I pin. By default, the Timing Analyzer
prohibits these paths.

● Set/Reset to Q Pin of Flip-flops allows or prohibits paths
through CLB flip-flop asynchronous Set or Reset inputs. By
default, the Timing Analyzer allows these paths.

The Timing Analyzer displays all blocks of that type in the
Included Blocks field. The name of this field changes to Excluded
Blocks when you select the last three block types.

3. Enter a filter in the Filter for Included/Excluded Blocks field to
display a subset of blocks of the specified type, if desired, and
click on Apply . For the first four selections in the Paths Through
field, this filter applies to the items that appear in the Included
Blocks list box. For the last three selections in the Paths Through
field, it applies to the items that appear in the Excluded Blocks list
box.
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4. Select the blocks that you want to exclude by moving them from
the Included Blocks list box to the Excluded Blocks list box.

5. Click on OK.

The Control Possible False Paths dialog box closes. You can now
select another filtering command or generate any timing report.

Breaking Logic Loops
The Break Logic Loops command instructs the Timing Analyzer to
treat combinatorial logic as synchronous timing elements, for
example, latch-based designs implemented with primitive gates. To
break logic loops, perform the following steps.

Once you select which logic loops to break, you can generate the
Performance To TimeSpecs, Performance Summary, or Detailed Path
report.

1. Select Path Filters ➝ Common Filters ➝ Break Logic
Loops .

The Timing Analyzer displays the Break Logic Loops dialog box,
as shown in Figure 4-27.
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Figure 4-27 Break Logic Loops Dialog Box

2. Enter a filter in the Filter for Available Nets field to display a
subset of available nets, if desired, and click on Apply .

3. Select the nets that you want to treat as synchronous timing
elements by moving them from the Available Nets list box to the
Selected Nets list box.

4. Click on OK.

The Break Logic Loops dialog box closes. You can now select
another filtering command or generate any timing report.

Resetting Path Filters to Defaults
You can reset the path filters to the defaults. For more information on
the Timing Analyzer default settings, refer to the “Viewing Timing
Analyzer Settings” section later in this chapter.

Note: To view current settings, select Analyze ➝ Show Settings .
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To reset the path filters, select Path Filters ➝ Reset Path
Filters .

Using the Console Window
The Console window records all the commands that you have used in
a Timing Analyzer session. You can use these commands to form
macros, as described in the next section, “Using Macros.” In addition,
it provides an alternative to using the menu commands by allowing
you to enter commands from the keyboard.

To open the Console window, click on View ➝ Console .

The Console window appears, as shown in Figure 4-28.

Figure 4-28 Console Window

You cannot delete text from the Console window.

You can add a command manually by typing it in the bar at the
bottom of the window below the Show Command and Its Status box.
Use the syntax given for the command in the “Keyboard Commands”
chapter of this manual. After you enter the command and press the
Return key, the command is reflected in the Console window.
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If you want to re-execute a command shown in the Console window,
you can use one of the following three methods in the bar at the
bottom of the window:

● Use the up or down arrow keys to move to the command, and
press the Return key.

● Type an exclamation point (!) and the number of the command.

● Type in an exclamation point (!) and the first letter or first few
letters of the command name.

With all these methods, the Timing Analyzer starts the search from
the bottom of the command list.

To see if the system issued a response to the command, such as an
error or warning message, click on the Show Command and its
Status  box.

Using Macros
The Macro commands on the File menu enable you to create, open,
and save a macro, which is a script file for running Timing Analyzer
commands and options.

You can use the Macro commands in conjunction with the Console
window, which records a history of all commands executed during
the current session.

Creating a Macro
To create a macro, perform the following steps.

1. Click on View ➝ Console  to open the Console window.

2. From the menus, select the commands that will constitute the
macro.

These commands are recorded in the Console window.

3. Select File ➝ New Macro .

The New Macro window appears, as shown in Figure 4-29. The
three macro icons now appear on the toolbar.
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Figure 4-29 New Macro Window and Icons

4. In the Console window, hold down the left mouse button and
highlight the sequence of commands that will constitute the
macro.

5. Click on the Copy icon, shown in Figure 4-30, in the upper left
corner of the Timing Analyzer screen.

Figure 4-30 Copy Icon

6. Position the cursor in the New Macro window and click on the
Paste icon, located just to the right of the Copy icon.

Figure 4-31 illustrates the Paste icon.
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Figure 4-31 Paste Icon

The lines from the Console window are now pasted into the New
Macro window.

You can also highlight, copy, and paste individual lines from the
Console window to the New Macro window.

You can add text in the New Macro window by inserting the
cursor and typing. Delete text by pressing the backspace key or by
highlighting and pressing the Delete key.

7. Save the new macro by following the instructions in the “Saving a
New Macro”section, following.

Saving a Macro
You can save a macro in a new file, the same file, or another existing
file.

Saving a New Macro

To save a new macro, follow these steps.

1. Click on File ➝ Save Macro .

The Save Macro As dialog box appears, as shown in Figure 4-32.
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Figure 4-32 Save Macro As Dialog Box

2. In the Drives field, select the drive in which you want to save the
macro.

3. In the Directories list box, select the directory in which you want
to save the macro.

4. In the File Name field, backspace over the asterisk and type in the
name of the file in which to save the macro.

You must save the macro in an XTM file, that is, a file with an .xtm
extension.

5. Click on OK.

Saving an Edited Macro to the Same File

If you want to save an edited macro in the same file, click on File ➝
Save Macro .

If you have saved the macro once, the Save Macro command saves
the macro in the specified file without activating the Save Macro As
dialog box.
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Saving an Edited Macro to a Different File

Follow this procedure if you want to save an edited macro to another
file.

1. Select File ➝ Save As Macro .

The Save Macro As dialog box appears, as shown earlier in Figure
4-32.

2. In the Drives field, select the drive in which you want to save the
macro.

3. In the Directories list box, select the directory in which you want
to save the macro.

4. If you want to save the macro in a new file, backspace over the
asterisk in the File Name field, and type in the name of the file in
which to store the macro. If you want to save the macro to the
existing file, click on the Save File as Type field, select the XTM file
type, then click on the name of the current file in the list box to
overwrite the existing macro.

A prompt asks you if you want to overwrite the current macro;
click on Yes .

You must save the macro in an XTM file, that is, a file with an .xtm
extension.

5. Click on OK.

Running a Macro
Follow these instructions to run an existing macro.

1. Select the File ➝ Open Macro  command.

The Open Macro File dialog box comes up, as indicated in
Figure 4-33.
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Figure 4-33 Open Macro File Dialog Box

2. In the Drives field, select the drive in which the macro file is
located.

3. In the Directories list box, select the directory in which the macro
file is located.

4. In the File Name field, backspace over the asterisk and type in the
name of the macro file that you want to open. Alternatively, click
on the List File as Type field and select the XTM file type category.
Then click on the name of the XTM file in the list box.

5. Click on OK.

The macro window opens and remains highlighted.

6. Select File ➝ Run Macro , or click on the Run Macro icon, shown
in Figure 4-34:

Figure 4-34 Run Macro Icon
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Editing a Macro
You can also edit an existing macro.

1. Click on File ➝ Open Macro .

The Open Macro File dialog box appears, which is shown in the
“Running a Macro” section.

2. In the Drives field, select the drive in which the macro file is
located.

3. In the Directories list box, select the directory in which the macro
file is located.

4. In the File Name field, backspace over the asterisk and type in the
name of the macro file that you want to open. Alternatively, click
on the List Files of Type field and select the XTM file type. Then
click on the name of the XTM file in the list box.

5. Click on OK.

The Open Macro File dialog box closes, and the macro window
appears.

6. Edit the macro, using the information in the “Creating a Macro”
section in this chapter to add, delete, copy, and paste commands
in the macro window.

7. If you want to save the edited macro in the same file, click on
File ➝ Save Macro .

If you have saved the macro once, the Save Macro command saves
the macro in the specified file without activating the Save Macro
As dialog box.

If you want to save the edited macro to another file, follow the
instructions in the “Saving an Edited Macro to a Different File”
section.

Suppressing Informational Messages
When you run a macro, the commands in the macro file can generate
informational, confirmational, and error messages. However, you can
suppress the informational and confirmational messages by using the
following procedure. You cannot suppress these messages with menu
commands, however.
Timing Analyzer Reference/User Guide 4-41



Timing Analyzer Reference/User Guide
1. Click on View ➝ Console .

2. In the bar at the bottom of the Console window, type in the
following:

Force -on

3. If you are creating a new macro, follow the procedure given in the
“Creating a Macro” section.

4. If you wish to suppress the messages for an existing macro, open
the macro, and cut and paste the Force command into the macro
using the instructions given in the “Creating a Macro” section.

5. Run the macro by selecting the File ➝ Run Macro  command or
the Run Macro icon.

6. To restore the informational and confirmational messages, type
the following:

Force -off

Changing the Speed Grade
The speed grade is usually set during the design implementation
process. Changing the speed grade helps you determine if you need
to target a faster device to meet your timing requirements. To change
the speed grade, perform the following steps.

1. Click on Options ➝ Change Speed Grade .

The Change Speed Grade dialog box appears, as shown in Figure
4-35.
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Figure 4-35 Change Speed Grade Dialog Box

2. Select a speed grade from the list of available speed grades using
one of the following methods.

● If you are using the mouse, click on the selection arrow and
select a speed grade.

● If you are using the keyboard, tab until the speed grade is
highlighted, and press the up or down arrow keys until the
appropriate speed grade appears.

3. Select OK.

Setting Delay Margins for the I/O
You can specify external delays for clock-to-setup or pad-to-setup
paths entering or exiting the device. This way, the Timing Analyzer
includes this external delay when calculating the delay for the path.
There is no default delay; the Timing Analyzer does not consider off-
chip delay unless you specify it with the following procedure.

To set the delay margins, perform the following steps.

1. Select Options ➝ Set Delay Margins for I/O .

The Set Delay Margins for I/O dialog box appears, as shown in
Figure 4-36.
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Figure 4-36 Set Delay Margins for I/O Dialog Box

2. Select the clock using either of the following methods.

● If you are using the mouse, click the down arrow by the Clock
field and select the appropriate clock.

● If you are using the keyboard, press the down arrow until the
appropriate clock appears in the Clock field. The Clock field
must be highlighted.

If the design has only one clock, it is displayed.

3. Select the path type: Pad To Setup or Clock to Pad. Pad To Setup is
the default.

The Timing Analyzer displays all the paths for the selected path
type.
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4. Enter a filter in the Filter for IOB Names field to display a subset
of the specified path type, if desired, and click on Apply .

5. Enter a delay margin value from 1 through 999 ns in the Margin
box.

6. Select the IOBs for which you want to set this delay margin.

7. Repeat steps 2 through 6 to select a different clock, change path
type, or change the delay margin.

8. Select OK to close the Set Delay Margins for I/O dialog box.

Viewing Timing Analyzer Settings
To view the Timing Analyzer default settings, select Analyze ➝
Show Settings .

The Timing Analyzer displays a pop-up window with the current
settings. Figure 4-37 gives an example of the Show Settings window.

Figure 4-37 Show Settings Window

When this window is the active window and you change an option
setting or a path filter, the change is immediately reflected in the
window. If it is not the active window and you change an option or a
filter, you must click inside the Show Settings window to update it
automatically.
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The default settings are as follows.

● Sort On –Descend

The Descending Delay option in the Sort By field in the Report
Options dialog box lists paths in order from longest to shortest
delays.

● Report –Normal

The Normal Report option in the Report Options dialog box
generates a report displaying a detailed list of path delays.

● OnlyLongestPaths –False

The Timing Analyzer reports all paths. If the Report Only Longest
Paths Between Points option in the Report Options dialog box is
set to True, the Timing Analyzer reports only the path with the
longest delay if there is more than one path between two end
points.

● SelectFailingTimespec –False

The Timing Analyzer reports all paths with timing specifications.
If you select the Report Paths Failing TimeSpec command from
the Path Filters menu, this option is set to True, indicating that the
Timing Analyzer reports the paths that do not meet the timing
specifications entered using the XACT-Performance utility.

● IncludeNoTimespec –False

The Timing Analyzer reports all timing specifications. If you select
the Report Paths With No TimeSpec command, this option is set to
True, indicating that the Timing Analyzer reports the paths
without timing specifications.

● Speed speedgrade

The default speed grade is derived from the LCA file, but you can
change the speed grade by selecting Change Speed Grade from
the Options menu.

You can change these settings using the commands on the Path Filters
and Options menus.
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Querying for Information
You may want to focus on the source, destination, and timing of a
particular net. You can obtain information about nets, blocks, timing
specifications, and timing groups by using the Query command. To
perform a query, follow this procedure.

1. Select Options ➝ Query .

The Query dialog box appears, as shown in Figure 4-38.

Figure 4-38 Query Dialog Box

2. Select the subject of the query by clicking on Nets, Blocks,
TimeSpec, or TimeGroup. Nets is the default.

The following information is displayed for each option.

● Nets — The Timing Analyzer shows the fanout, the timing
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from the source CLB to each of the destination CLBs, and the
CLB names.

● Blocks — The Timing Analyzer displays the CLB names, the
pins on the CLBs, and the names of the clocks and signals
attached to these pins. In a net binding table, it shows which
nets are attached to the pins on a CLB, the function of each
function generator in the CLB, the internal blocks in the CLB,
and the external connections. It indicates if the block is
unconfigured and unused in the design, and notes the
configuration options used. For more information on all of
these elements, consult the “XACT Design Editor” chapter of
the Development System Reference Guide.

● TimeSpec — The Timing Analyzer lists the timing
specifications defined in XACT-Performance.

● TimeGroup — The Timing Analyzer lists the elements and the
output nets in the specified timing groups.

3. Enter a filter, if desired, and click on Apply .

You can specify a minimum net delay in nanoseconds in the Delay
Greater Than field, but only if you selected Nets. The Timing
Analyzer displays only those paths that have a delay greater than
or equal to the specified value. If you enter a value in both the
Delay Greater Than and filter field, the Timing Analyzer lists the
nets that meet both criteria.

4. Select the nets, blocks, timing specifications, or timing groups that
you want to query.

5. Click on Query .

The Timing Analyzer displays the Query report in a pop-up
window.
4-48 Xilinx Development System



Chapter 5
Timing Analyzer Reference/User Guide — 0401312 01 5-1

Menu Commands

This chapter lists and describes all the commands available in the
menus of the Timing Analyzer window. They are listed in
alphabetical order. It also lists the Timing Analyzer toolbar icons.

For a description of the fields that are common to many Timing
Analyzer dialog boxes, such as OK and Cancel, see the “Dialog
Boxes” section of the “Getting Started” chapter.

Menus
The Timing Analyzer has seven menus, which are described in the
following sections.

File Menu
The File menu contains commands that load a design, save and print
reports on that design, and exit the Timing Analyzer. It also contains
macro commands. The commands on the File menu are the
following:

Open Loads design for timing analysis or opens
existing report

Close Report Closes file
Save Report Saves report in active window to specified

file
New Macro Creates new macro
Open Macro Opens existing macro
Run Macro Runs macro
Save Macro Saves new macro to specified file
Save As Macro Saves edited macro to specified file
Print Sends report in active window to default

printer
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Printer Setup Specifies printer settings
Exit Exits the Timing Analyzer

Analyze Menu
The Analyze menu contains commands that generate timing reports
and display the settings of the Timing Analyzer options.

Performance to TimeSpecs Generates report indicating
whether design meets timing
specifications

Performance Summary Generates report indicating
overall design performance

Detailed Path Report Generates report containing
worst-case path delays for all
paths in design

Check for Asynchronous Logic Generates report indicating
whether LCA file contains logic
not controlled by a register

Show Clocks Generates report listing all clocks
in design

Show Settings Lists option settings
Find Finds text string in report files

Path Filters Menu
The Path Filters menu contains commands that enable you to select a
subset of information when generating a timing report.

TimeSpec Filters Reports paths constrained by
timing specifications

Report Paths FailingTimeSpec Lists paths not meeting timing
specifications

Report Paths With No TimeSpec Lists paths with no timing
specifications

Ignore TimeSpecs Ignores timing specifications
Path Analysis Filters Defines paths to be analyzed
Select Sources Defines path starting points
Select Destinations Defines path ending points
Select Path Types Selects path type to analyze
Common Filters Applies filters common to

Performance To TimeSpecs,
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Performance Summary, and
Detailed Path reports

Include Paths With Nets Selects specific nets to be analyzed
Exclude Paths With Nets Ignores specific nets during

analysis
Control Possible False Paths Prevents tracing of false paths
Break Logic Loops Treats combinatorial logic as

synchronous timing elements
Reset Path Filters Causes path filters to revert to

default

Options Menu
The Options menu contains commands that you can use to change
the speed grade, delay margins, and report options.

Change Speed Grade Selects speed grade
Set Delay Margins for I/O Adds extra delay to input and

output paths
Report Options Determines format and content of

reports
Query Displays information about

groups of elements

View Menu
The View menu contains commands that govern the appearance of
Timing Analyzer window.

Toolbar Displays or hides toolbar
Status bar Displays or hides status bar
Console Displays or hides Console

window

Window Menu
The Window menu contains commands that control the placement of
the windows on the main screen.

Tile Arranges open windows in rows
Cascade Arranges open windows

diagonally
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Arrange Icons Arranges icons in row at bottom of
screen

Help Menu
The Help menu contains commands that enable you to access online
help for the Timing Analyzer.

Contents Lists online help topics
Search for Help On Searches for specific topic
Tutorial Activates interactive tutorial
About Timing Analyzer Shows current software version

Commands
The following commands are available in the menus of the Timing
Analyzer’s graphical user interface.

About Timing Analyzer (Help Menu)
The About Timing Analyzer command brings up a pop-up window
that displays the version number of the Timing Analyzer software.

Arrange Icons (Window Menu)
The Arrange Icons command arranges the icons in the Timing
Analyzer window in a row along the bottom of the window.

Break Logic Loops (Path Filters Menu)
The Break Logic Loops command treats combinatorial logic as
synchronous timing elements.

Use this path filter in conjunction with any of the following reports:

● Performance To TimeSpecs report, which compares the
implementation of the design to the XACT-Performance
constraints

● Performance Summary report, which indicates overall design
performance

● Detailed Path report, which contains detailed timing information
for all paths in the design
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This command activates the Break Logic Loops dialog box, shown in
Figure 5-1.

Figure 5-1 Break Logic Loops Dialog Box

The Break Logic Loops dialog box displays the following fields.

● Filter for Available Nets limits the nets displayed in the Available
Nets list box to those you specify.

● Apply executes the filter indicated in the Filter for Available
Nets box and displays the subset in the Available Nets list box.

● Clear deletes the filter and redisplays all the nets in the
Available Nets list box.

● Available Nets lists the nets to be treated as synchronous timing
elements, which you select in the Filter for Available Nets field. If
you do not specify a filter, it lists all the nets in the design.

● Selected Nets lists the nets to be treated as synchronous timing
elements.
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● Add (>) moves the selected nets from the Available Nets list box to
the Selected Nets list box.

● Add All (>>) moves all the listed nets from the Available Nets list
box to the Selected Nets list box.

● Remove (<) moves the selected nets from the Selected Nets list box
to the Available Nets list box.

● Remove All (<<) moves all listed nets from the Selected Nets list
box to the Available Nets list box.

Cascade (Window Menu)
The Cascade command arranges the open windows diagonally down
the screen so that they overlap one on top of another, as shown in
Figure 5-2. The active window is on top.
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Figure 5-2 Cascaded Windows

Change Speed Grade (Options Menu)
The Change Speed Grade command allows you to select a speed
grade in the Change Speed Grade dialog box, shown in Figure 5-3.
The default is the speed grade set in the LCA file.
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Figure 5-3 Change Speed Grade Dialog Box

Check for Asynchronous Logic (Analyze Menu)
The Check for Asynchronous Logic command checks the LCA file for
logic that is not controlled by a register. It issues the results in the
Check for Asynchronous Logic report.

Close Report (File Menu)
The Close Report command closes the active report window.

Common Filters (Path Filters Menu)
The Common Filters command brings up a submenu containing the
following filtering commands, which apply to the Performance To
TimeSpecs, Performance Summary, and Detailed Path reports.

● Include Paths With Nets

● Exclude Paths With Nets

● Control Possible False Paths

● Break Logic Loops

Refer to the alphabetical listings of these commands for an
explanation of their functions.
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Console (View Menu)
The Console command displays the Console window, shown in
Figure 5-4, which records all the commands that you have used in a
Timing Analyzer session.

Figure 5-4 Console Window

You cannot delete text from the Console window.

You can add a command manually by typing it in the bar at the
bottom of the window below the Show Command and Its Status box.
Use the syntax given for the command in the “Keyboard Commands”
chapter of this manual. After you enter the command and press the
Return key, the command is reflected in the Console window.

If you want to re-execute a command shown in the Console window,
you can use one of the following three methods in the bar at the
bottom of the window:

● Use the up or down arrow keys to move to the command, and
press the Return key.

● Type an exclamation point (!) and the number of the command.

● Type an exclamation point (!) and the first letter or first few letters
of the command name.
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With all these methods, the Timing Analyzer starts the search for the
command from the bottom of the command list.

When you click on the Show Command and Its Status box, the
Timing Analyzer displays any responses to a command, such as an
error or warning message.

Contents (Help Menu)
The Contents command lists the online help topics available for the
Timing Analyzer. From the opening screen, you can jump to
command information or step-by-step instructions for using the
Timing Analyzer. Once you open help, you can click the Contents
button (first button on the left) in the Help window whenever you
want to return to the help topic list.

Pressing the F1 key is the same as selecting the Contents command.

Control Possible False Paths (Path Filters Menu)
The Control Possible False Paths command controls whether the
Timing Analyzer traces false paths through RAM, 3-state buffers,
input and output pins, and Set/Reset logic.

Use this path filter in conjunction with any of the following reports.

● Performance To TimeSpecs report, which compares the
implementation of the design to the XACT-Performance
constraints

● Performance Summary report, which indicates overall design
performance

● Detailed Path report, which contains detailed timing information
for all paths in the design

It activates the Control Possible False Paths dialog box, shown in
Figure 5-5.
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Figure 5-5 Control Possible False Paths Dialog Box

This dialog box displays the following fields.

● Paths Through specifies the paths that the Timing Analyzer can
trace. The paths can be the following.

● Data Input of CLB RAM allows or prohibits paths through the
data inputs of a CLB RAM. By default, the Timing Analyzer
allows these paths.

● Write Enable of CLB RAM allows or prohibits paths through
the write-enable input of a CLB RAM. By default, the Timing
Analyzer allows these paths.

● Tristate to Output Pin of BUFT allows or prohibits paths that
go through a BUFT T pin to the BUFT O pin. By default, the
Timing Analyzer allows these paths.
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● Input Pin to Output Pin of BUFT allows or prohibits paths that
go through the BUFT I pin to the BUFT O pin. By default, the
Timing Analyzer allows these paths.

● Output Pin to Input Pin of IOB allows or prohibits paths that
go from the IOB O pin to the pad and back into the chip
through the IOB I pin. By default, the Timing Analyzer
prohibits these paths.

● Tristate Pin to Input Pin of IOB allows or prohibits paths that
go from the IOB T pin to the pad and back into the chip
through the IOB I pin. By default, the Timing Analyzer
prohibits these paths.

● Set/Reset to Q Pin of Flip-flops allows or prohibits paths
through CLB flip-flop asynchronous Set or Reset inputs. By
default, the Timing Analyzer prohibits these paths.

Once you select a block type, the Timing Analyzer displays all
blocks of that type in the Included Blocks list box. The name of
this field changes to Excluded Blocks when you select the last
three block types.

● Filter for Included/Excluded Blocks limits the blocks that the
Timing Analyzer can trace paths through to those you specify.

● Apply executes the filter indicated in the Filter for Included
Blocks box and displays the subset in the Included Blocks list
box.

● Clear deletes the filter and redisplays all the blocks in the
Included Blocks list box.

For the first four selections in the Paths Through field, this filter
applies to the items that appear in the Included Blocks list box. For
the last three selections in the Paths Through field, it applies to the
items that appear in the Excluded Blocks list box.

● Included Blocks lists the blocks that the Timing Analyzer can trace
paths through, which you select in the Filter for Included Blocks
field. If you do not specify a filter, it lists all the blocks in the
design.

● Excluded Blocks lists the blocks that the Timing Analyzer will not
trace paths through.
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● Add (>) moves the selected blocks from the Included Blocks list
box to the Excluded Blocks list box.

● Add All (>>) moves all the listed blocks from the Included Blocks
list box to the Excluded Blocks list box.

● Remove (<) moves the selected blocks from the Excluded Blocks
list box to the Included Blocks list box.

● Remove All (<<) moves all listed blocks from the Excluded Blocks
list box to the Included Blocks list box.

Detailed Path Report (Analyze Menu)
The Detailed Path Report command generates the Detailed Path
report, which contains a detailed analysis of all specified paths and
includes the worst-case path delays for all paths in the design.

You can use the following path filters to narrow the scope of this
report:

● Select Sources

● Select Destinations

● Select Path Types

● Include Paths With Nets

● Exclude Paths With Nets

● Control Possible False Paths

● Break Logic Loops

Exclude Paths With Nets (Path Filters Menu)
The Exclude Paths With Nets command excludes the specified nets
from timing analysis.

Use this path filter in conjunction with any of the following reports:

● Performance To TimeSpecs report, which compares the
implementation of the design to the XACT-Performance
constraints

● Performance Summary report, which indicates overall design
performance
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● Detailed Path report, which contains detailed timing information
for all paths in the design

This command activates the Exclude Paths With Nets dialog box,
shown in Figure 5-6.

Figure 5-6 Exclude Paths With Nets Dialog Box

This dialog box includes the following fields.

● Filter for Included Nets limits the nets displayed in the Included
Nets list box to those you specify.

● Apply executes the filter indicated in the Filter for Included
Nets box and displays the subset in the Included Nets list box.

● Clear deletes the filter and redisplays all the nets in the
Included Nets list box.

● Included Nets lists the nets to be included in the timing analysis,
which you select in the Filter for Included Nets field. If you do not
specify a filter, it lists all the nets in the design.

● Excluded Nets lists the nets to be ignored in the timing analysis.
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● Add (>) moves the selected nets from the Included Nets list box to
the Excluded Nets list box.

● Add All (>>) moves all the listed nets from the Included Nets list
box to the Excluded Nets list box.

● Remove (<) moves the selected nets from the Excluded Nets list
box to the Included Nets list box.

● Remove All (<<) moves all listed nets from the Excluded Nets list
box to the Included Nets list box.

Exit (File Menu)
The Exit command exits the Timing Analyzer. If you have unsaved
reports open, a prompt box similar to that in Figure 5-7 appears.

Figure 5-7 Exit Prompt Box

The three options on this prompt box are the following.

● Yes brings up the Save Report dialog box, shown in Figure 5-21, so
you can specify a file name.

● No exits the Timing Analyzer without saving the report.

● Cancel cancels the exit operation.

Find (Analyze Menu)
The Find command brings up the Find dialog box, pictured in Figure
5-8, which allows you to search for a text string within a Timing
Analyzer report.
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Figure 5-8 Find Dialog Box

The Find dialog box contains the following fields:

● Find What allows you to enter the text string to search for.

● Match Case finds only instances that have the same case as the text
string. By default, it ignores the case of the text.

● Match Whole Word finds only instances of the text string that are
whole words, not part of a larger word. By default, it finds any
instance of the text string, whether the instance is embedded in
another word or not.

● Direction indicates the direction to search:

● Up searches backwards from the present location of the cursor
to the beginning of the report. It stops at the beginning of the
report.

● Down searches forwards from the present location of the
cursor to the end of the report. It stops at the end of the report.
This direction is the default.

● Find Next finds the next instance of the text string you are
searching for.

Ignore TimeSpecs (Path Filters Menu)
The Ignore TimeSpecs command prevents the Timing Analyzer from
reporting selected timing specifications.

Use this path filter in conjunction with the Performance To TimeSpecs
report, which compares the implementation of the design to the
XACT-Performance constraints.
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The Ignore TimeSpecs command activates the Ignore TimeSpecs
dialog box, shown in Figure 5-9.

Figure 5-9 Ignore TimeSpecs Dialog Box

The Ignore TimeSpecs dialog box displays the following fields.

● Filter for Selected TimeSpecs limits the timing specifications
displayed in the Selected TimeSpecs list box to those you specify.

● Apply executes the filter indicated in the Filter for Selected
TimeSpecs box and displays the subset in the Selected
TimeSpecs list box.

● Clear deletes the filter and redisplays all the timing
specifications in the Selected TimeSpecs list box.

● Selected TimeSpecs lists the timing specifications to be included in
the timing analysis, which you selected in the Filter for Selected
TimeSpecs field. If you do not specify a filter, it lists all the timing
specifications in the design.
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● Ignored TimeSpecs lists all the timing specifications to be ignored
in the current timing analysis.

● Add (>) moves the selected timing specifications from the Selected
TimeSpecs list box to the Ignored TimeSpecs list box.

● Add All (>>) moves all listed timing specifications from the
Selected TimeSpecs list box to the Ignored TimeSpecs list box.

● Remove (<) moves the selected timing specifications in the
Ignored TimeSpecs list box to the Selected TimeSpecs list box.

● Remove All (<<) moves all listed timing specifications in the
Ignored TimeSpecs list box to the Selected TimeSpecs list box.

Include Paths With Nets (Path Filters Menu)
The Include Paths With Nets command selects specific nets to be
analyzed.

Use this path filter in conjunction with any of the following
commands:

● Performance To TimeSpecs report, which compares the
implementation of the design to the XACT-Performance
constraints

● Performance Summary report, which indicates overall design
performance

● Detailed Path report, which contains detailed timing information
for all paths in the design

This command activates the Include Paths With Nets dialog box,
shown in Figure 5-10.
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Figure 5-10 Include Paths With Nets Dialog Box

This dialog box includes the following fields.

● Filter for Excluded Nets limits the nets displayed in the Excluded
Nets list box to those you specify.

● Apply executes the filter indicated in the Filter for Excluded
Nets box and displays the subset in the Excluded Nets list box.

● Clear deletes the filter and redisplays all the nets in the
Excluded Nets list box.

● Excluded Nets lists the nets to be ignored in the timing analysis,
which you select in the Filter for Excluded Nets field. If you do
not specify a filter, it lists all the nets in the design.

● Included Nets lists the nets to be included in the timing analysis.

● Add (>) moves the selected nets from the Excluded Nets list box
to the Included Nets list box.
Timing Analyzer Reference/User Guide 5-19



Timing Analyzer Reference/User Guide
● Add All (>>) moves all the listed nets from the Excluded Nets list
box to the Included Nets list box.

● Remove (<) moves the selected nets from the Included Nets list
box to the Excluded Nets list box.

● Remove All (<<) moves all listed nets from the Included Nets list
box to the Excluded Nets list box.

New Macro (File Menu)
The New Macro command enables you to create a new macro by
cutting the appropriate sequence of commands from the Console
window and pasting it in the New Macro window, shown in
Figure 5-11.

Figure 5-11 New Macro Window

Open (File Menu)
The Open command loads a routed LCA design file for timing
analysis, or loads a report (XRP) file. It brings up the Open Design/
Report File dialog box, shown in Figure 5-12.
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Figure 5-12 Open Design/Report File Dialog Box

This dialog box contains the following fields.

● File Name consists of a space for you to type in the name of the
design (LCA) file or report (XRP) file that you want to load
(backspace over the asterisk) or a list box where you can click on
the name of the design.

● List Files of Type indicates whether the file to be opened is a
design file or a report file.

● Directories lists the directories for the specified drive so you can
select the directory that contains the design or report file that you
want to load.

● Drives lists the drives to which the PC is connected so you can
select the drive on which the file is located.

● Network accesses the network drive so you can connect to a
printer on the network. It activates the Printers - Network
Connections dialog box, shown under the Printer Setup command
in this chapter. Consult the Microsoft Windows documentation or
click on the Help button for an explanation of the fields on this
dialog box. The Network option is only available if you are
running Windows for Workgroups.
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● Read Only has no function in the Timing Analyzer.

Open Macro (File Menu)
The Open Macro command opens an existing macro (XTM) file. It
brings up the Open Macro File dialog box, shown in Figure 5-13:

Figure 5-13 Open Macro File Dialog Box

This dialog box contains the following fields.

● File Name consists of a space for you to type in the name of the
macro file that you want to load (backspace over the asterisk) or a
list box where you can click on the name of the macro file.

● List Files of Type indicates the category of file to be listed in the
File Name list box; it must be an XTM file.

● Directories lists the directories for the specified drive so you can
select the directory where your macro file is located.

● Drives lists the drives to which the PC is connected so you can
select the drive where your macro file is located.

● Network accesses the network drive so you can connect to a
printer on the network. It activates the Printers - Network
Connections dialog box, shown under the Printer Setup command
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in this chapter. Consult the Microsoft Windows documentation or
click on the Help button for an explanation of the fields on this
dialog box. The Network option is only available if you are
running Windows for Workgroups.

Path Analysis Filters (Path Filters Menu)
The Path Analysis Filters command brings up a submenu containing
the following commands, which allow you to the define paths that
you want to analyze.

● Select Sources

● Select Destinations

● Select Path Types

Refer to the alphabetical listings of these commands for an
explanation of their functions.

Performance Summary (Analyze Menu)
The Performance Summary command generates the Performance
Summary report, which displays the maximum clock frequencies for
all clocks in the design and the worst-case timing for all clock paths.

You can use the following path filters to narrow the scope of this
report:

● Select Sources

● Select Destinations

● Select Path Types

● Include Paths With Nets

● Exclude Paths With Nets

● Control Possible False Paths

● Break Logic Loops

Performance To TimeSpecs (Analyze Menu)
The Performance To TimeSpecs command generates the Performance
To TimeSpecs report, which indicates whether the design meets the
timing specifications entered using XACT-Performance.
Timing Analyzer Reference/User Guide 5-23



Timing Analyzer Reference/User Guide
You can use the following path filters to narrow the scope of this
report:

● Report Paths Failing TimeSpec

● Report Paths With No TimeSpec

● Ignore TimeSpecs

● Include Paths With Nets

● Exclude Paths With Nets

● Control Possible False Paths

● Break Logic Loops

Print (File Menu)
The Print command displays the Print dialog box, which sends the
report that is displayed in the active window to the default printer
and allows you to indicate how many copies to print. Figure 5-14
shows an example of this dialog box.

Figure 5-14 Print Dialog Box

The three options on this prompt box are the following.

● OK exits the dialog box and prints the specified file.

● Cancel exits the dialog box without printing the file.
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● Setup activates the Print Setup dialog box, shown in
Figure 5-15.

Printer Setup (File Menu)
The Printer Setup command sends any report to a printer other than
the default printer for your site and allows you to change printer
options. It activates the Print Setup dialog box, shown in
Figure 5-15.

Figure 5-15 Print Setup Dialog Box

This dialog box contains the following fields.

● Default Printer allows you to select the default printer for your
site.

● Specific Printer allows you to specify an alternative printer.

● Orientation allows you to print in either portrait (vertical) mode
or landscape (horizontal) mode.

● Paper consists of the following two fields.

● Size allows you to select the size of paper to print on.

● Source determines whether the paper to be printed on is
automatically or manually fed to the printer. Select Upper Tray
for automatic feed or Manual Feed for manual feed.
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● Options brings up the Options dialog box, shown in Figure 5-16.

Figure 5-16 Options Dialog Box

Consult the Microsoft Windows documentation or click on the
Help button for an explanation of the fields on this dialog box.

● Network accesses the network drive so you can connect to a
printer on the network. It activates the Printers - Network
Connections dialog box, shown in Figure 5-17. Consult the
Microsoft Windows documentation or click on the Help button for
an explanation of the fields on this dialog box. The Network
option is only available if you are running Windows for
Workgroups.
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Figure 5-17 Printers - Network Connections Dialog Box

Query (Options Menu)
The Query command displays information about the specified delay
group, that is, nets, blocks, timing specifications, or timing groups. It
activates the Query dialog box, shown in Figure 5-18.
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Figure 5-18 Query Dialog Box

The Query dialog box contains the following fields:

● Filter provides a space in which to specify a subset of nets, blocks,
timing specifications, or timing groups.

● Delay Greater Than specifies a minimum net delay in
nanoseconds. The Timing Analyzer displays only those paths that
have a delay greater than or equal to the specified value. You can
enter a value in this field only when you select Nets. If you enter a
value in both the Delay Greater Than and the filter field, the
Timing Analyzer lists the nets that meet both criteria.

● Apply executes the filter indicated in the Filter box and
displays the subset in the Available Nets/Blocks/TimeSpecs/
TimeGroups list box.
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● Clear deletes the filter and redisplays all the nets in the
Available Nets/Blocks/TimeSpecs/TimeGroups list box.

● Nets requests information about nets. When you select this
option, the Timing Analyzer shows the fanout, the timing from
the source CLB to each of the destination CLBs, and the CLB
names.

● Blocks requests information about blocks, or CLBs. The Timing
Analyzer displays the CLB names, the pins on the CLBs, and the
names of the clocks and signals attached to these pins. In a net
binding table, it shows which nets are attached to the pins on a
CLB, the function of each function generator in the CLB, the
internal blocks in the CLB, and the external connections. It
indicates if the block is unconfigured and unused in the design
and notes the configuration options used. For more information
on all of these elements, consult the “XACT Design Editor”
chapter of the Development System Reference Guide.

● TimeSpec requests information about timing specifications. The
Timing Analyzer lists the timing specifications defined in XACT-
Performance.

● TimeGroup requests information about timing groups. The
Timing Analyzer lists the elements and the output nets in the
specified timing groups.

● Available Nets/Blocks/TimeSpecs/TimeGroups displays all the
available net, block, timing specification, or timing group
elements on which you can obtain information.

● Selected Nets/Blocks/TimeSpecs/TimeGroups displays only
those net, block, timing specification, or timing group elements
that you have selected.

● Query exits the dialog box and displays the requested information
in a pop-up window.

● Add (>) moves the selected elements from the Available Nets/
Blocks/TimeSpecs/TimeGroups list box to the Selected Nets/
Blocks/TimeSpecs/TimeGroups list box.

● Add All (>>) moves all the listed elements from the Available
Nets/Blocks/TimeSpecs/TimeGroups list box to the Selected
Nets/Blocks/TimeSpecs/TimeGroups list box.
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● Remove (<) moves the selected elements from the Selected Nets/
Blocks/TimeSpecs/TimeGroups list box to the Available Nets/
Blocks/TimeSpecs/TimeGroups list box.

● Remove All (<<) moves all listed elements from the Selected
Nets/Blocks/TimeSpecs/TimeGroups list box to the Available
Nets/Blocks/TimeSpecs/TimeGroups list box.

Report Options (Options Menu)
The Report Options command determines the appearance of a report
and the information that it contains. It activates the Report Options
dialog box, shown in Figure 5-19, so you can customize the Timing
Analyzer reports.

Figure 5-19 Report Options Dialog Box
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The Report Options dialog box contains the following fields.

● Maximum Number of Paths limits the total number of paths that
the Timing Analyzer reports. This option can be useful when
system memory is limited because it limits the number of paths
stored in memory. By default, the Timing Analyzer analyzes all
paths in the design.

● Report Delays Less Than instructs the Timing Analyzer to report
only those paths that have a delay less than or equal to the
specified value. By default, the Timing Analyzer reports all paths
regardless of their delay.

● Report Delays Greater Than instructs the Timing Analyzer to
report only those paths that have a delay greater than or equal to
the specified value. By default, the Timing Analyzer reports all
paths regardless of their delay.

● Sort By defines the order in which the paths are reported. It offers
the following six options.

● Ascending Delay lists paths in order from shortest to longest
delays.

● Descending Delay, the default, lists paths in order from longest
to shortest delays.

● Source Block sorts path delays by the source block name,
which is useful when trying to determine the worst-case delay
from a given block.

● Destination Block sorts path delays by the destination block
name, which can help determine the worst-case path to each
block.

● Source Clock Net sorts path delays by the clock name that
sources the first element in a path, which separates delay
information for two or more clock nets in a design.

● Destination Clock Net sorts path delays by the clock name that
sources the last element in a path.

● The Report Only Longest Paths Between Points check box directs
the Timing Analyzer to report only the path with the longest
delay if there is more than one path between two end points. By
default, the Timing Analyzer reports all paths.
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● Short Report generates a report containing only the path source
and end point. This report lists one delay path per line and does
not display cumulative delays through CLBs.

● Wide Report creates a report formatted into 132 characters per
line, which prevents long block and net names from being
truncated.

● Normal Report, the default, produces a report displaying a
detailed list of path delays.

Report Paths Failing TimeSpec (Path Filters Menu)
The Report Paths Failing TimeSpec command lists only the paths that
do not meet the timing specifications entered using XACT-
Performance.

Use this path filter in conjunction with the Performance To TimeSpecs
report, which compares the implementation of the design to the
XACT-Performance constraints.

Report Paths With No TimeSpec (Path Filters Menu)
The Report Paths With No TimeSpec command reports paths that do
not have timing specifications.

Use this path filter in conjunction with the Performance To TimeSpecs
report, which compares the implementation of the design to the
XACT-Performance constraints.

Reset Path Filters (Path Filters Menu)
The Reset Path Filters command causes path filters to revert to the
defaults. For the defaults, see the Show Settings command.

Run Macro (File Menu)
The Run Macro command runs the specified macro, which is a script
file that contains Timing Analyzer commands, filters, and/or report
options.
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Save As Macro (File Menu)
The Save As Macro command saves the edited macro to another file.
It brings up the Save Macro As dialog box, which is the same dialog
box activated by the Save Macro command. This dialog box is
displayed in Figure 5-20.

Figure 5-20 Save Macro As Dialog Box

The Save Macro As dialog box contains the following fields:

● File Name consists of a space for you to type in the name of the
file in which to store the macro (backspace over the asterisk). It
also offers a list box where you can click on the name of an
existing file to overwrite with a new macro.

● Save File as Type allows you to select a category of file type to
display in the File Name list box. XTM files are the only category
available for macros.

● Directories lists the directories for the specified drive so you can
select the directory in which to save your macro file.

● Drives lists the drives to which the PC is connected so you can
select the drive on which to save the macro file.
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● Network accesses the network drive so you can connect to a
printer on the network. It activates the Printers - Network
Connections dialog box, shown under the Printer Setup command
in this chapter. Consult the Microsoft Windows documentation or
click on the Help button for an explanation of the fields on this
dialog box. The Network option is only available if you are
running Windows for Workgroups.

Save Macro (File Menu)
The Save Macro command saves macros created with the New Macro
command. It activates the Save Macro As dialog box, shown in Figure
5-20. If you have saved the macro once, the Save Macro command
saves the macro in the specified file without activating the Save
Macro As dialog box.

Save Report (File Menu)
The Save Report command saves the report in the active window to a
specified file. It brings up the Save Report dialog box, shown in
Figure 5-21.

Figure 5-21 Save Report Dialog Box
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This dialog box contains the following fields.

● File Name consists of a space for you to type in the name of the
file in which to store the report (backspace over the asterisk). It
also offers a list box where you can click on the name of an
existing file to overwrite with a new report.

● Save File as Type allows you to select a category of file type to
display in the File Name list box. By default, if you do not specify
a file extension, the Timing Analyzer saves the file as an XRP file,
that is, as a file with an .xrp extension.

● Directories lists the directories for the specified drive so you can
select the directory in which to save the report file.

● Drives lists the drives to which the PC is connected so you can
select the drive on which to save the report file.

● Network accesses the network drive so you can connect to a
printer on the network. It activates the Printers - Network
Connections dialog box, shown under the Printer Setup command
in this chapter. Consult the Microsoft Windows documentation or
click on the Help button for an explanation of the fields on this
dialog box. The Network option is only available if you are
running Windows for Workgroups.

Search for Help On (Help Menu)
The Search for Help On command brings up a pop-up window that
lets you search for a specific topic.

Select Destinations (Path Filters Menu)
The Select Destinations command allows you to define a path’s
ending points, which can be flip-flops, IOBs, clocks, nets, pins, CLBs,
or all types.

Use this path filter in conjunction with the Performance Summary
report, which indicates overall design performance. You can also use
this filter with the Detailed Path report, which contains detailed
timing information for all paths in the design.

This command brings up the Select Destinations dialog box, shown
in Figure 5-22.
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Figure 5-22 Select Destinations Dialog Box

This dialog box contains the following fields:

● Destination Type in the upper left-hand corner lists the
destination type, that is, Flip-Flops, IOBs, Clocks, Nets, Pins,
CLBs, or All. The default is Flip-Flops.

● Edge determines whether the destination is a clock’s rising edge,
falling edge, or either edge. This option is available only when
you select Clocks in the Destination Type field.

● Filter for Available Destinations allows you to limit the
destination to a particular element or elements within the
indicated category.

● Apply executes the filter indicated in the Filter for Available
Destinations box and displays the subset in the Available
Destinations list box.
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● Clear deletes the filter and redisplays all the destinations of the
default type in the Available Destinations list box.

● Available Destinations lists all the individual destinations for the
specified destination type. You can display a subset by entering a
filter in the Filter for Available Destinations box.

● Selected Destinations displays all the individual destinations that
you selected for the specified destination type.

● Add (>) moves the selected elements from the Available
Destinations list box to the Selected Destinations list box.

● Add All (>>) moves all the listed elements from the Available
Destinations list box to the Selected Destinations list box.

● Remove (<) moves the selected elements from the Selected
Destinations list box to the Available Destinations list box.

● Remove All (<<) moves all listed elements from the Selected
Destinations list box to the Available Destinations list box.

Select Path Types (Path Filters Menu)
The Select Path Types command selects the path types to report. By
default, the Timing Analyzer reports timing delays for all path types.

Use this path filter in conjunction with the Performance Summary
report, which indicates overall design performance. You can also use
this filter with the Detailed Path report, which contains detailed
timing information for all paths in the design.

This command brings up the Select Path Types dialog box, shown in
Figure 5-23.
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Figure 5-23 Select Path Types Dialog Box

The Select Path Types dialog box contains the following fields. For a
description of these paths, see the “Timing Analysis” chapter.

● Clock To Setup reports clock-to-setup paths.

● Clock To Pad reports clock-to-pad paths.

● Pad To Setup reports pad-to-setup paths.

● Paths Ending At Clock Pin of Flip-flop reports clock input paths.

● Pad To Pad reports pad-to-pad paths.

Select Sources (Path Filters Menu)
The Select Sources command allows you to define a path’s starting
points, which can be flip-flops, IOBs, clocks, nets, pins, CLBs, or all
types.

Use this path filter in conjunction with the Performance Summary
report, which indicates overall design performance. You can also use
this filter with the Detailed Path report, which contains detailed
timing information for all paths in the design.

The Select Sources command activates the Select Sources dialog box,
shown in Figure 5-24.
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Figure 5-24 Select Sources Dialog Box

The Select Sources dialog box displays the following fields:

● Source Type in the upper left-hand corner lists the source type,
that is, Flip-Flops, IOBs, Clocks, Nets, Pins, CLBs, or All. The
default is Flip-Flops.

● Edge determines whether the source is a clock’s rising edge,
falling edge, or either edge. This option is available only when
you select Clocks in the Source Type field.

● Filter for Available Sources allows you to limit the source to a
particular element or elements within the indicated source type.

● Apply executes the filter indicated in the Filter for Available
Sources box and displays the subset in the Available Sources
list box.
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● Clear deletes the filter and redisplays all the sources of the
default type in the Available Sources list box.

● Available Sources lists all the individual sources for the specified
source type. You can display a subset by entering a filter in the
Filter for Available Sources box.

● Selected Sources displays all the individual sources that you
selected for the specified source type.

● Add (>) moves the selected elements from the Available Sources
list box to the Selected Sources list box.

● Add All (>>) moves all the listed elements from the Available
Sources list box to the Selected Sources list box.

● Remove (<) moves the selected elements from the Selected
Sources list box to the Available Sources list box.

● Remove All (<<) moves all listed elements from the Selected
Sources list box to the Available Sources list box.

Set Delay Margins for I/O (Options Menu)
The Set Delay Margins for I/O command adds extra delay to input
and output paths that travel off-chip. Setting a delay margin enables
you to determine a more realistic clock speed. This command
activates the Set Delay Margins for I/O dialog box, shown in Figure
5-25.
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Figure 5-25 Set Delay Margins for I/O Dialog Box

This dialog box contains the following fields.

● Pad To Setup displays the pad-to-setup paths for the specified
clock in the IOBs list box. It is selected by default.

● Clock To Pad displays the clock-to-pad paths for the specified
clock in the IOBs list box.

● Clock lists the clocks in the design. You can set delay margins for
each clock in the design.

● Margin specifies the amount of delay to add to the delay from the
source to the pad. It can be a value from 1 through 999 ns.

● Filter for IOB Names limits the IOBs driven by the clock that you
selected to those that you specify.
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● Apply executes the filter indicated in the Filter for IOB Names
box and displays the subset in the IOBs list box.

● Clear deletes the filter and redisplays all the IOBs in the IOBs
list box.

● IOBs lists the IOBs driven by the clock that you specified in the
Clock field.

● Defined Margins lists the IOBs to which the delay is to be applied.

● Add (>) moves the selected elements from the IOBs list box to the
Defined Margins list box.

● Add All (>>) moves all the listed elements from the IOBs list box
to the Defined Margins list box.

● Remove (<) moves the selected elements from the Defined
Margins list box to the IOBs list box.

● Remove All (<<) moves all listed elements from the Defined
Margins list box to the IOBs list box.

Show Clocks (Analyze Menu)
The Show Clocks command creates the Show Clocks report, which
lists the names of all clocks in the design.

Show Settings (Analyze Menu)
The Show Settings command lists the settings of the Timing Analyzer
options set with the commands on the Path Filters and Options
menus. The “How to Use the Timing Analyzer” chapter gives an
example of the window that appears when you select this command.

The default settings are as follows.

● Sort On –Descend

The Descending Delay option in the Sort By field in the Report
Options dialog box lists paths in order from longest to shortest
delays.

● Report –Normal

The Normal Report option in the Report Options dialog box
generates a report displaying a detailed list of path delays.
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● OnlyLongestPaths –False

The Timing Analyzer reports all paths. If the Report Only Longest
Paths Between Points option in the Report Options dialog box is
set to True, the Timing Analyzer reports only the path with the
longest delay if there is more than one path between two end
points.

● SelectFailingTimespec –False

The Timing Analyzer reports all paths with timing specifications.
If you select the Report Paths Failing TimeSpec command from
the Path Filters menu, this option is set to True, indicating that the
Timing Analyzer reports the paths that do not meet the timing
specifications entered using the XACT-Performance utility.

● IncludeNoTimespec –False

The Timing Analyzer reports all timing specifications. If you
select the Report Paths With No TimeSpec command, this option
is set to True, indicating that the Timing Analyzer reports the
paths without timing specifications.

● Speed speedgrade

This option lists the speed grade specified in the LCA file, but you
can change the speed grade by selecting Change Speed Grade
from the Options menu.

Status Bar (View Menu)
The Status Bar command controls whether or not the status bar is
displayed. It is displayed by default.

Tile (Window Menu)
The Tile command arranges the open windows in rows across the
Timing Analyzer screen. The windows are fitted into all available
screen space without overlapping, as Figure 5-26 demonstrates.
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Figure 5-26 Tiled Windows

TimeSpec Filters (Path Filters Menu)
The TimeSpec Filters command brings up a submenu containing the
following commands, which report paths constrained by timing
specifications entered with XACT-Performance.

● Report Paths Failing TimeSpec

● Report Paths With No TimeSpec

● Ignore TimeSpecs

Refer to the alphabetical listings of these commands for an
explanation of their functions.
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Toolbar (View Menu)
The Toolbar command controls whether or not the toolbar is
displayed. It is displayed by default. See the “Toolbar Icons” section,
following, for a description of the icons on the toolbar.

Tutorial (Help Menu)
The Tutorial command activates an interactive tutorial
demonstrating some of the procedures available in the Timing
Analyzer.

Toolbar Icons
You can access some of the Timing Analyzer commands through
toolbar icons. The Timing Analyzer window displays the following
icons. The Copy, Paste, and Run Macro icons appear only when you
click on the File ➝ New Macro command. When you move the cursor
over each icon, an identifying label appears over it and in the status
bar. These icons are discussed in the order that they appear on the
toolbar.

Open Design File Icon
The Open Design File icon, shown in Figure 5-27, opens a design for
timing analysis. It is equivalent to the File ➝ Open command.

Figure 5-27 Open Design Icon

Save Icon
The Save icon, shown in Figure 5-28, saves the active report window
to a specified file. It is equivalent to the File ➝ Save Report command.

Figure 5-28 Save Report Icon
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Print Report Icon
The Print Report icon, shown in Figure 5-29, sends the report
displayed in the active window to the default printer. It is equivalent
to the File ➝ Print command.

Figure 5-29 Print Report Icon

Performance To Timespec Icon
The Performance To Timespec icon, shown in Figure 5-30, generates
the Performance To TimeSpecs report, which compares the
implementation of the design to the XACT-Performance constraints.
It is equivalent to the Analyze ➝ Performance To TimeSpecs
command.

Figure 5-30 Performance To TimeSpec Icon

Design Performance Summary Icon
The Design Performance Summary icon, shown in Figure 5-31,
generates the Performance Summary report, which indicates overall
design performance. It is equivalent to the Analyze ➝ Performance
Summary command.

Figure 5-31 Design Performance Summary Icon

Detailed Analysis Icon
The Detailed Analysis icon, shown in Figure 5-32, generates the
Detailed Path report, which contains worst-case path delays for all
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paths in the design. It is equivalent to the Analyze ➝ Detailed Path
Report command.

Figure 5-32 Detailed Analysis Icon

Help Icon
The Help icon, shown in Figure 5-33, displays information about a
menu command or option when you click on it. The information is
displayed in a pop-up window. See the “Obtaining Help” section of
the “Getting Started” chapter for more information.

Figure 5-33 Context-Sensitive Help Icon

Copy Icon
The Copy icon, shown in Figure 5-34, copies the highlighted
commands in the Console window so that you can paste them into
the New Macro window to form a new macro. The Copy icon
appears only when you click on the New Macro command from the
File menu.

Figure 5-34 Copy Icon

Paste Icon
The Paste icon pastes the commands highlighted in the Console
window into the New Macro window to form a new macro. This icon
is shown in Figure 5-35. It appears only when you click on the New
Macro command from the File menu.
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Figure 5-35 Paste Icon

Run Macro Icon
The Run Macro icon runs an existing macro, which you open with the
File ➝ Open Macro command. The Run Macro icon appears only
when you click on the New Macro command from the File menu. It is
equivalent to the File ➝ Run Macro command. Figure 5-36 displays
this icon.

Figure 5-36 Run Macro Icon
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Keyboard Commands

This chapter describes all the commands that you can enter from the
keyboard in the Timing Analyzer’s Console or New Macro window.
They are listed in alphabetical order.

The syntax of these commands is case-insensitive.

For more information on issuing commands through the Console
window, see the “Using the Console Window” section of the “How to
Use the Timing Analyzer” chapter. For instructions on using these
commands to build macros, see the “Using Macros” section of the
same chapter.

BreakLogicLoop Treats combinatorial logic as synchronous
timing elements

CheckAsynch Generates report indicating whether LCA
file contains logic not controlled by a
register

ControlPathTracing Prohibits tracing of false paths
DefineEndpts Defines path starting and ending points
DelayGreaterThan Specifies minimum delay
DelayLessThan Specifies maximum delay
DesignSummary Generates report indicating overall design

performance
DetailAnalysis Generates report containing worst-case

path delays for all paths in design
ExcludeNets Ignores specific nets during analysis
Exit Exits the Timing Analyzer
Force Suppresses messages when macro is run
IgnoreTimespec Ignores timing specifications
IncludeNet Selects specific nets to be analyzed
IncludeNoTimespec Lists paths with no timing specifications
MaxNoPaths Limits the total number of paths that
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Timing Analyzer reports
MaxNoPathsPerTimespec Limits number of paths reported per

timing specification
OnlyLongestPaths Reports only paths with longest delay
OpenDesign Loads a design for timing analysis
PerformToTimespec Generates report indicating whether

design meets timing specifications
Query Displays information about groups of

elements
Report Determines format of reports
ResetFilters Causes path filters to revert to default
RunMacro Runs macro
SelectFailingTimespec Lists paths not meeting timing

specifications
SelectPathType Selects path type to analyze
SetMargins Adds extra delay to input and output

paths
ShowClockNets Generates report listing all clocks in design
SortOn Defines order in which paths are reported
Speed Selects speed grade

BreakLogicLoop
The BreakLogicLoop command allows combinatorial logic to be
treated as synchronous timing elements, for example, latch-based
designs implemented with primitive gates.

This command corresponds to the Path Filters ➝ Common Filters ➝
Break Logic Loops menu command.

Syntax
The syntax of the BreakLogicLoop command is the following:

BreakLogicLoop {-net} element_name element_name ...

● –Net indicates that the logic loop is to be broken at a net.

● Element_name is the names of the nets or blocks where the logic
loop is to be broken.
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Abbreviation
You can abbreviate the BreakLogicLoop command syntax as follows:

bll {-n} element_name

Example
Following is an example of the BreakLogicLoop command:

breaklogicloop -net $1N24

CheckAsynch
The CheckAsynch command checks the LCA file for logic that is not
controlled by a register. It issues the results in the Check for
Asynchronous Logic report.

This command corresponds to the Analyze ➝ Check for
Asynchronous Logic menu command.

Syntax
The syntax of the CheckAsynch command is the following:

CheckAsynch [-save filename]

● –Save indicates that you can optionally save the output of the
CheckAsynch command in a file. If this option is not specified, the
report appears in a window.

● Filename is the name of the saved file.

Abbreviation
You can abbreviate the CheckAsynch command syntax as follows:

ca [-save filename]

Example
Following is an example of the CheckAsynch command:

checkasynch -save predesign.xrp
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ControlPathTracing
The ControlPathTracing command controls whether the Timing
Analyzer traces false paths through RAM, 3-state buffers, input and
output pins, and Set/Reset logic.

This command corresponds to the Path Filters ➝ Common Filters ➝
Control Possible False Paths menu command.

Syntax
The syntax of the ControlPathTracing command is the following:

ControlPathTracing { -DataInput |-WriteEnable
|-TristateToOutput |-TristateToInput |-SetResetToQ
|-OutputToInput |-InputToOutput } block_name block_name
...

● –DataInput allows or prohibits paths through the data inputs of a
CLB RAM. By default, the Timing Analyzer allows these paths.

● –WriteEnable allows or prohibits paths through the write-enable
input of a CLB RAM. By default, the Timing Analyzer allows these
paths.

● –TristateToOutput allows or prohibits paths that go through a
BUFT T pin to the BUFT O pin. By default, the Timing Analyzer
allows these paths.

● –TristateToInput allows or prohibits paths that go from the IOB T
pin to the pad and back into the chip through the IOB I pin. By
default, the Timing Analyzer prohibits these paths.

● –SetResetToQ allows or prohibits paths through CLB flip-flop
asynchronous Set or Reset inputs. By default, the Timing Analyzer
prohibits these paths.

● –OutputToInput allows or prohibits paths that go from the IOB O
pin to the pad and back into the chip through the IOB I pin. By
default, the Timing Analyzer prohibits these paths.

● –InputToOutput allows or prohibits paths that go through the
BUFT I pin to the BUFT O pin. By default, the Timing Analyzer
allows these paths.

● Block_name is the names of the CLBs that the path goes through.
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Abbreviation
You can abbreviate the ControlPathTracing command syntax as
follows:

cpt { -di |-we |-tto |-tti |-srq |-oti |-ito } block_name
block_name ...

Example
Following is an example of the ControlPathTracing command:

controlpathtracing -writeenable CLB_R4C4

DefineEndpts
The DefineEndpts command selects the starting points and ending
points of the paths that you want to analyze.

This command corresponds to the Path Filters ➝ Path Analysis
Filters ➝ Select Sources and the Path Filters ➝ Path Analysis Filters
➝ Select Destinations menu commands.

Syntax
The syntax of the DefineEndpts command is the following:

DefineEndpts { -FromIOBs |-ToIOBs } IOB_name
DefineEndpts { -FromCLB |-ToCLB } CLB_name
DefineEndpts { -FromNet |-ToNet } net_name
DefineEndpts { -FromPin |-ToPin } pin_name
DefineEndpts { -FromFlipflop |-ToFlipflop } flip-
flop_name
DefineEndpts { -FromRising |-ToRising } clock_name
DefineEndpts { -FromFalling |-ToFalling } clock_name
DefineEndpts { -FromAny |-ToAny } { pin_name|CLB_name|
net_name}
DefineEndpts { -FromAll |-ToAll }

● –FromIOBs selects IOBs as starting points for the path to be
analyzed.

● –ToIOBs selects IOBs as ending points for the path to be analyzed.
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● –FromCLB selects CLBs as starting points for the path to be
analyzed.

● –ToCLB selects CLBs as ending points for the path to be analyzed.

● –FromNet selects nets as starting points for the path to be
analyzed.

● –ToNet selects nets as ending points for the path to be analyzed.

● –FromPin selects pins as starting points for the path to be
analyzed.

● –ToPin selects the ending points for the path to be analyzed.

● –FromFlipflop selects flip-flops as starting points for the path to be
analyzed.

● –ToFlipflop selects flip-flops as ending points for the path to be
analyzed.

● –FromRising selects rising clock edges as starting points for the
path to be analyzed.

● –ToRising selects rising clock edges as ending points for the path
to be analyzed.

● –FromFalling selects falling clock edges as starting points for the
path to be analyzed.

● –ToFalling selects falling clock edges as ending points for the path
to be analyzed.

● –FromAny selects any clock edges as starting points for the path
to be analyzed.

● –ToAny selects any clock edges as ending points for the path to be
analyzed.

● –FromAll selects paths that begin at any path source.

● –ToAll selects paths that end at any path destination.

● CLB_name is the name of the CLB that is the starting or ending
point of the path to be analyzed.

● IOB_name is the name of the IOB that is the starting or ending
point of the path to be analyzed.
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● Flip-flop_name is the name of the flip-flop that is the starting or
ending point of the path to be analyzed.

● Net_name is the name of the net that is the starting or ending point
of the path to be analyzed.

● Clock_name is the name of the clock that is the starting or ending
point of the path to be analyzed.

● Pin_name is the name of the pin that is the starting or ending point
of the path to be analyzed.

The defaults are –FromAll and –ToAll.

Abbreviation
You can abbreviate the DefineEndpts command syntax as follows:

def { -fiobs |-tiobs } IOB_name
def { -fclb |-tclb } CLB_name
def { -fnet |-tnet } net_name
def { -fpin |-tpin } pin_name
def { -fff |-tff } flip-flop_name
def { -fris |-tris } clock_name
def { -ffal |-tfal } clock_name
def { -fany |-tany }  {pin_name|CLB_name| net_name}
def { -fall |-tall }

These parameters have the same respective meanings as the
parameters in the longer form of the syntax.

Example
Following are examples of the DefineEndpts command:

defineendpts -fromflipflop CNT3Q0 CNT3Q1

defineendpts -toiobs P80 P68

DelayGreaterThan
The DelayGreaterThan command specifies a minimum delay in
nanoseconds. The Timing Analyzer reports only those paths that
have a delay greater than or equal to the specified value. By default,
the Timing Analyzer reports all paths regardless of their delay.
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This command corresponds to the Report Delays Greater Than field
on the Report Options dialog box, which is activated by the Options
➝ Report Options menu command.

Syntax
The syntax of the DelayGreaterThan command is the following:

DelayGreaterThan delay

Delay is the minimum delay in nanoseconds.

Abbreviation
You can abbreviate the DelayGreaterThan command syntax as
follows:

dg delay

Example
Following is an example of the DelayGreaterThan command:

delaygreaterthan 30

DelayLessThan
The DelayLessThan command specifies a maximum delay in
nanoseconds. The Timing Analyzer reports only those paths that
have a delay less than or equal to the specified value. By default, the
Timing Analyzer reports all paths regardless of their delay.

This command corresponds to the Report Delays Less Than option on
the Report Options dialog box, which is activated by the Options ➝
Report Options menu command.

Syntax
The syntax of the DelayLessThan command is the following:

DelayLessThan delay

Delay is the maximum delay in nanoseconds.
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Abbreviation
You can abbreviate the DelayLessThan command syntax as follows:

dl delay

Example
Following is an example of the DelayLessThan command:

delaylessthan 30

DesignSummary
The DesignSummary command creates the Performance Summary
report, a short report that calculates the maximum clock frequencies
for all clocks in the design and displays the worst-case timing for all
clock paths.

This command is equivalent to the Analyze ➝ Performance
Summary menu command.

Syntax
The syntax of the DesignSummary command is the following:

DesignSummary -filters [ -save filename]

● –Filters is a keyword that is required when you use the
DesignSummary command.

● –Save indicates that you can optionally save the Performance
Summary report in a file. If this option is not specified, the report
appears in a window.

● Filename is the name of the file in which the Performance
Summary report is saved.

Abbreviation
You can abbreviate the DesignSummary command syntax as follows:

ds -fil [ -s filename]
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Example
Following is an example of the DesignSummary command:

designsummary -save postdesign.xrp

DetailAnalysis
The DetailAnalysis command creates the Detailed Path report, a long
report that displays a detailed analysis of all specified paths.

This command is equivalent to the Analyze ➝ Detailed Path Report
menu command.

Syntax
The syntax of the DetailAnalysis command is the following:

DetailAnalysis [ -save filename]

● –Save indicates that you can optionally save the Detailed Path
report in a file. If this option is not specified, the report appears in
a window.

● Filename is the name of the file in which the Detailed Path report is
saved.

Abbreviation
You can abbreviate the DetailAnalysis command syntax as follows:

da [ -s filename]

Example
Following is an example of the DetailAnalysis command:

detailanalysis -save xredesign.xrp

ExcludeNets
The ExcludeNets command excludes specific nets from being
analyzed.

This command corresponds to the Path Filters ➝ Common Filters ➝
Exclude Paths With Nets menu command.
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Syntax
The syntax of the ExcludeNets command is the following:

ExcludeNets [ net_name1 net_name2 ... ]

Net_name1, net_name2, and so forth are the names of the nets to be
excluded.

Abbreviation
You can abbreviate the ExcludeNets command syntax as follows:

exnet [ net_name1 net_name2 ... ]

Example
Following is an example of the ExcludeNets command:

excludenets $1N95 CNT5 CNT6 CNT7 EXT_CLK1
EXT_CLK2

Exit
The Exit command exits the Timing Analyzer.

This command is equivalent to the File ➝ Exit menu command.

Syntax
The syntax of the Exit command is the following:

exit

Abbreviation
You can abbreviate the Exit command syntax as follows:

e

Example
Following is an example of the Exit command:

exit
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Force
When you run a macro, the commands in the macro file can generate
informational, confirmational, and error messages. When the Force
command is set to –On, the Timing Analyzer suppresses the
informational and confirmational messages. Only error messages
continue to appear. Force –Off restores the appearance of all three
types of message.

This command does not have an equivalent menu command.

Syntax
The syntax of the Force command is the following:

Force { -on |-off }

–On suppresses the informational and confirmational messages, and
–Off restores them. –On is the default.

Abbreviation
You can abbreviate the Force command syntax as follows:

fr { -on |-off }

Example
Following is an example of the Force command:

force -on

IgnoreTimespec
The IgnoreTimespec command prevents the Timing Analyzer from
analyzing the specified timing specifications.

This command corresponds to the Path Filters ➝ TimeSpec Filters ➝
Ignore TimeSpecs menu command.

Syntax
The syntax of the IgnoreTimespec command is the following:

IgnoreTimespec [ timespec1 timespec2 ... ]
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Timespec1, timespec2, and so forth are the names of the timing
specifications to be ignored.

Abbreviation
You can abbreviate the IgnoreTimespec command syntax as follows:

ignt [ timespec1 timespec2 ... ]

Example
Following is an example of the IgnoreTimespec command:

ignoretimespec TS08 TS09 TS10

IncludeNet
The IncludeNet command specifies the nets to be analyzed.

This command corresponds to the Path Filters ➝ Common Filters ➝
Include Paths With Nets menu command.

Syntax
The syntax of the IncludeNet command is the following:

IncludeNet [ net_name1 net_name2]

Net_name1, net_name2, and so forth are the nets to be analyzed.

Abbreviation
You can abbreviate the IncludeNet command syntax as follows:

incn [ net_name1 net_name2 ... ]

Example
Following is an example of the IncludeNet command:

includenet in2_1 in2_2
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IncludeNoTimespec
The IncludeNoTimespec command restricts the Timing Analyzer to
reporting paths without timing specifications.

This command is equivalent to the Path Filters ➝ TimeSpec Filters ➝
Report Paths With No TimeSpec menu command.

Syntax
The syntax of the IncludeNoTimespec command is the following:

IncludeNoTimespec { -true |-false }

● –True reports the paths with no timing specifications.

● –False does not report the paths with no timing specifications.
This option is the default.

Abbreviation
You can abbreviate the IncludeNoTimespec command syntax as
follows:

int { -t |-f }

Example
Following is an example of the IncludeNoTimespec command:

includenotimespec -true

MaxNoPaths
The MaxNoPaths command limits the total number of paths that the
Timing Analyzer reports. This option can be useful when system
memory is limited because it limits the number of paths stored in
memory. By default, the Timing Analyzer analyzes all paths.

The command corresponds to the Maximum Number of Paths field
on the Report Options dialog box, which is activated by the Options
➝ Report Options menu command.
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Syntax
The syntax of the MaxNoPaths command is the following:

MaxNoPaths number_of_paths

Number_of_paths is the maximum number of paths that the Timing
Analyzer reports.

Abbreviation
You can abbreviate the MaxNoPaths command syntax as follows:

mnp number_of_paths

Example
Following is an example of the MaxNoPaths command:

maxnopaths 20

MaxNoPathsPerTimespec
The MaxNoPathsPerTimespec command limits the number of paths
reported per timing specification.

This command does not have an equivalent menu command.

Syntax
The syntax of the MaxNoPathsPerTimespec command is the
following:

MaxNoPathsPerTimespec number_of_paths

Number_of_paths is the maximum number of paths per timing
specification that the Timing Analyzer reports.

Abbreviation
You can abbreviate the MaxNoPathsPerTimespec command syntax as
follows:

mnppt number_of_paths
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Example
Following is an example of the MaxNoPathsPerTimespec command:

maxnopathspertimespec 5

OnlyLongestPaths
The OnlyLongestPaths command restricts the Timing Analyzer to
reporting only the path with the longest delay if there is more than
one path between two end points. By default, the Timing Analyzer
reports all paths.

This command corresponds to the Report Only Longest Paths
Between Points check box on the Report Options dialog box, which is
activated by the Options ➝ Report Options menu command.

Syntax
The syntax of the OnlyLongestPaths command is the following:

OnlyLongestPaths { -true |-false }

● –True includes only the longest paths; it is the default when you
generate the Performance Summary report.

● –False includes all paths; it is the default when you generate any
report except the Performance Summary report.

Abbreviation
You can abbreviate the OnlyLongestPaths command syntax as
follows:

olp { -t |-f }

Example
Following is an example of the OnlyLongestPaths command:

OnlyLongestPaths -false
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OpenDesign
The OpenDesign command opens a placed and routed LCA file for
timing analysis.

This command corresponds to the File ➝ Open menu command.

Syntax
The syntax of the OpenDesign command is the following:

OpenDesign drive:\pathname\filename.lca

● Drive is the letter of the drive containing the directory in which
the LCA file is located.

● Pathname is the directory in which the LCA file is located.

● Filename is the name of the LCA file.

This command does not open a report (XRP) file.

Abbreviation
You can abbreviate the OpenDesign command syntax as follows:

od drive:\pathname\filename.lca

Example
Following is an example of the OpenDesign command:

opendesign h:\berkeley\ta\4002a.lca

PerformToTimespec
The PerformToTimespec command generates the Performance To
TimeSpecs report, which compares design performance to the timing
specifications entered using XACT-Performance.

This command is equivalent to the Analyze ➝ Performance To
TimeSpecs menu command.
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Syntax
The syntax of the PerformToTimespec command is the following:

PerformToTimespec [ -save filename]

● –Save indicates that you can optionally save the Performance to
Timespecs report in a file. If this option is not specified, the report
appears in a window.

● Filename is the name of the file in which the Performance to
Timespecs report is saved.

Abbreviation
You can abbreviate the PerformToTimespec command syntax as
follows:

ptt [ -s filename]

Example
Following is an example of the PerformToTimespec command:

performtotimespec -save mercury.xrp

Query
The Query command reports information about nets, blocks, timing
specifications, and timing groups. See the section describing the
Query command in the “Menu Commands” chapter for the specific
information that this command reports.

This command is the same as the Options ➝ Query menu command.

Syntax
The syntax of the Query command is the following:

query { -net |-block |-timespec |-timegroup }
element_name

● –Net reports information about nets.

● –Block reports information about blocks.

● –Timespec reports information about timing specifications.
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● –Timegroup reports information about timing groups.

● Element_name can be the following:

● Net name when you select the –Net option.

● Block name when you select the –Block option.

● Timing specification, or TSid number, when you select the
–Timespec option.

● Timing group name when you select the –Timegroup option.

Abbreviation
You can abbreviate the Query command syntax as follows:

qy { -n |-b |-tp |-tg } element_name

Example
Following are examples of the Query command:

query -timespec 05

query -block CLB_R1C1

Report
The Report command determines the format of the report output.

This command corresponds to the Short Report, Wide Report, and
Normal Report options on the Report Options dialog box, which is
activated by the Options ➝ Report Options menu command.

Syntax
The syntax of the Report command is the following:

report { -short |-wide |-normal }

● –Short displays only the path source and end point. This format
lists one delay path per line and does not display cumulative
delays through CLBs.

● –Wide sets a format of 132 characters per line, which prevents
long block and net names from being truncated.
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● –Normal, the default, displays a detailed list of path delays.

Abbreviation
You can abbreviate the Report command syntax as follows:

r { -s |-w |-n }

Example
Following is an example of the Report command:

report -short

ResetFilters
The ResetFilters command resets the path filters to the system
defaults. Refer to the “Show Settings” section of the “Main Window
Commands” chapter for a listing of these defaults.

This command is equivalent to the Path Filters ➝ Reset Path Filters
menu command.

Syntax
The syntax of the ResetFilters command is the following:

ResetFilters

Abbreviation
You can abbreviate the ResetFilters command syntax as follows:

rf

Example
Following is an example of the ResetFilters command:

resetfilters
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RunMacro
The RunMacro command runs an existing macro.

This command corresponds to the File ➝ Run Macro menu
command.

Syntax
The syntax of the RunMacro command is the following:

RunMacro filename

Filename is the name of the macro file.

Abbreviation
You can abbreviate the RunMacro command syntax as follows:

runm filename

Example
Following is an example of the RunMacro command:

runmacro timespec.xtm

SelectFailingTimespec
The SelectFailingTimespec command lists only the paths that do not
meet the timing specifications entered using XACT-Performance.

This command corresponds to the Path Filters ➝ TimeSpec Filters ➝
Report Paths Failing TimeSpec menu command.

Syntax
The syntax of the SelectFailingTimespec command is the following:

SelectFailingTimespec { -true |-false }

● –True includes only the paths that do not meet your timing
specifications.

● –False includes all paths. This setting is the default.
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Abbreviation
You can abbreviate the SelectFailingTimespec command syntax as
follows:

sft { -t | -f }

Example
Following is an example of the SelectFailingTimespec command:

selectfailingtimespec -true

SelectPathType
The SelectPathType command selects the types of paths reported by
the Timing Analyzer. By default, the Timing Analyzer analyzes all
path types.

This command is equivalent to the Path Filters ➝ Path Analysis
Filters ➝ Select Path Types menu command.

Syntax
The syntax of the SelectPathType command is the following:

SelectPathType
[ ClockToSetup |ClockToPad |PadToSetup |
PadToPad|PathsEndingAtFF ]

● ClockToSetup is a clock-to-setup path.

● ClockToPad is a clock-to-pad path.

● PadToSetup is a pad-to-setup path.

● PadToPad is a pad-to-pad path.

● PathsEndingAtFF is a clock input path.

For information about these path types, see the “Timing Analysis”
chapter. By default, all path types are selected.
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Abbreviation
You can abbreviate the SelectPathType command syntax as follows:

spt [ cts | ctp | pts | ptp | peaff ]

These parameters have the same respective meanings as the
parameters in the longer form of the syntax.

Example
Following is an example of the SelectPathType command:

selectpathtype padtosetup

SetMargins
The SetMargins command specifies external delays for clock-to-pad
or pad-to-setup paths entering or exiting the device. This way, the
Timing Analyzer includes this external delay when calculating the
delay for the path.

This command corresponds to the Options ➝ Set Delay Margins for
I/O menu command.

Syntax
The syntax of the SetMargins command is the following:

SetMargins { -P2S block_name clock_name delay_margin|
-C2P clock_name block_name delay_margin}

● –P2S is a pad-to-setup path.

● –C2P is a clock-to-pad path.

● Block_name is the name of the IOB for which you want to set the
delay margin.

● Clock_name is the name of the clock.

● Delay_margin is the delay margin value; it can be from 1 to 999 ns,
inclusive.

There is no default delay; the Timing Analyzer does not consider off-
chip delay unless you specify it.
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Abbreviation
You can abbreviate the SetMargins command syntax as follows:

sm { -P2S block_name clock_name delay_margin|
-C2P clock_name block_name delay_margin}

Example
Following is an example of the SetMargins command:

setmargins -c2p CLK1 EXT_IN1 10

ShowClockNets
The ShowClockNets command creates the Show Clocks report, which
lists the names of all clocks in the design.

This command is the same as the Analyze ➝ Show Clocks menu
command.

Syntax
The syntax of the ShowClockNets command is the following:

ShowClockNets [ -save filename]

● –Save indicates that you can optionally save the Show Clocks
report in a file. If this option is not specified, the report appears in
a window.

● Filename is the name of the saved file.

Abbreviation
You can abbreviate the ShowClockNets command syntax as follows:

scn [ -s filename]

Example
Following is an example of the ShowClockNets command:

showclocknets -save triad1.xrp
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SortOn
The SortOn command defines the order in which the paths are
reported.

This command is equivalent to the Sort By option on the Report
Options dialog box, which is activated by the Options ➝ Report
Options menu command.

Syntax
The syntax of the SortOn command is the following:

SortOn { -Ascend |-Descend |-SourceBlk |-DestBlk |
-SourceClkNet |-DestClkNet }

● –Ascend lists paths in order from shortest to longest delays.

● –Descend, the default, lists paths in order from longest to shortest
delays.

● –SourceBlk sorts path delays by the source block name, which is
useful when trying to determine the worst-case delay from a
given block.

● –DestBlk sorts path delays by the destination block name, which
can help determine the worst-case path to each block.

● –SourceClkNet sorts path delays by the clock name that sources
the first element in a path, which separates delay information for
two or more clock nets in a design.

● –DestClkNet sorts path delays by the clock name that sources the
last element in a path.

Abbreviation
You can abbreviate the SortOn command syntax as follows:

sort { -a |-d |-sb |-db |-scn |-dcn }

Example
Following is an example of the SortOn command:

sorton -sourceblk
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Speed
The Speed command sets the speed grade. Changing the speed grade
helps you determine if you need to target a faster device to meet your
timing requirements. The default speed grade is set in the LCA file.

This command is the same as the Options ➝ Change Speed Grade
menu command.

Syntax
The syntax of the Speed command is the following:

speed speedgrade

Speedgrade can be any of the speed grades available for the
architecture used. You can obtain this information from the Design
Manager or the Timing Analyzer’s graphical interface.

Abbreviation
You can abbreviate the Speed command syntax as follows:

sp speedgrade

Example
Following is an example of the Speed command:

speed -5
6-26 Xilinx Development System



Appendix A
Timing Analyzer Reference/User Guide — 0401312 01 A-1

Glossary

This chapter defines the key terms and concepts that you must
understand to use the Timing Analyzer effectively. The terms are
listed in alphabetical order.

Clock Input Path
A clock input path starts at either an input of the chip or at the output
of a flip-flop, latch, or RAM. It ends at any clock pin on a flip-flip or
latch enable. The clock input path time is the maximum time required
for the signal to arrive at the flip-flop clock input. Clock input paths
help to determine system-level design timing.

Clock-to-Pad Path
A clock-to-pad (C2P) path starts at the Q output of a flip-flop or latch
and ends at an output of the chip. It includes the clock-to-Q delay of
the flip-flop and the path delay from that flip-flop to the chip output.
The clock-to-pad path time is the maximum time required for the
data to leave the source flip-flop, travel through logic and routing,
and leave the chip.

Clock-to-Setup Path
A clock-to-setup (C2S) path starts at the Q output of a flip-flop or
latch and ends at an input to another flip-flop, latch, or RAM, where
that pin has a setup requirement before a clocking signal. It includes
the clock-to-Q delay of a flip-flop, the path delay from that flip-flop to
the next flip-flop, and the setup requirement of the next flip-flop. The
clock-to-setup path time is the maximum time required for the data
to propagate through the source flip-flop, travel through the logic
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and routing, and arrive at the destination before the next clock edge
occurs.

Clock Skew
Clock skew is the difference between the time a clock signal arrives at
the source flip-flop in a path and the time it arrives at the destination
flip-flop. It is also referred to as clock delay.

Critical Path
A critical path is a signal in a section of combinatorial logic that limits
the speed of the logic. Storage elements start and end a critical path,
which may include I/O pads.

Hold Time
Hold time is the time following a clock event during which the data
input to a latch or flip-flop must remain stable in order to guarantee
that the latched data is correct.

Pad-to-Pad Path
A pad-to-pad (P2P) path starts at an input of the chip and ends at an
output of the chip. The pad-to-pad path time is the maximum time
required for the data to enter the chip, travel through logic and
routing, and leave the chip. It is not controlled or affected by any
clock signal.

Pad-to-Setup Path
A pad-to-setup (P2S) path starts at an input of the chip and ends at an
input to a flip-flop, latch, or RAM — wherever there is a setup time
against a control signal. The pad-to-setup path time is the maximum
time required for the data to enter the chip, travel through logic and
routing, and arrive at the output before the clock or control signal
arrives.
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Setup Time
Setup time is the time prior to a clock event during which the data
input to a latch or flip-flop must remain stable in order to guarantee
that the latched data is correct.

Static Timing Analysis
A static timing analysis is a point-to-point delay analysis of a design
network. It does not include insertion of stimulus vectors.

Timing Specifications
Timing specifications define the maximum allowable delay on any
given set of paths in a design. They are entered on the schematic with
the XACT-Performance utility.
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XDelay Command Equivalents

XDelay Equivalents in the Timing Analyzer
If you previously used XDelay, the following table lists the XDelay
commands and options and their Timing Analyzer equivalents.

Note: The commands on the Profile menu in XDelay have no
equivalent in the Timing Analyzer.

Table 6-1  XDelay Commands and Timing Analyzer Equivalents

XDelay Command
 Timing Analyzer

Keyboard Command
 Timing Analyzer
Menu Command

Analyze DesignSummary –filters Analyze ➝ Performance
Summary

ClearMargins SetMargins Options ➝ Set Delay Mar-
gins for I/O

ClearTemplate ResetFilters Path Filters ➝ Reset Path
Filters

DeleteGroup No equivalent No equivalent

DeleteSpec IgnoreTimespec Path Filters ➝ TimeSpec Fil-
ters ➝ Ignore TimeSpecs

Design OpenDesign File ➝ Open design_name

Directory OpenDesign File ➝ Open ➝ Directories

DOS No equivalent No equivalent

DRC CheckAsynch Analyze ➝ Check for Asyn-
chronous Logic

Execute RunMacro No equivalent
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Exit Exit  File ➝ Exit

Flagblk ControlPathTracing Path Filters ➝ Common Fil-
ters ➝ Control Possible
False Paths

IOB_Enable_O_I
IOB_Disable_O_I

ControlPathTracing
–OutputToInput

Path Filters ➝ Common Fil-
ters ➝ Control Possible
False Paths ➝ Output Pin to
Input Pin of IOB

IOB_Enable_T_I
IOB_Disable_T_I

ControlPathTracing
–TristateToInput

Path Filters ➝ Common Fil-
ters ➝ Control Possible
False Paths ➝ Tristate Pin to
Input Pin of IOB

TBUF_Enable_I_O
TBUF_Disable_I_O

ControlPathTracing
–InputToOutput

Path Filters ➝ Common Fil-
ters ➝ Control Possible
False Paths ➝ Input Pin to
Output Pin of BUFT

TBUF_Enable_T_O
TBUF_Disable_T_O

ControlPathTracing
–TristateToOutput

Path Filters ➝ Common Fil-
ters ➝ Control Possible
False Paths ➝ Tristate to
Output Pin of BUFT

CLB_Enable_WE
CLB_Disable_WE

ControlPathTracing
–WriteEnable

Path Filters ➝ Common Fil-
ters ➝ Control Possible
False Paths ➝ Write Enable
of CLB RAM

CLB_Enable_DIN
CLB_Disable_DIN

ControlPathTracing
–DataInput

Path Filters ➝ Common Fil-
ters ➝ Control Possible
False Paths ➝ Data Input of
CLB RAM

CLB_Enable_SR_Q
CLB_Disable_SR_Q

ControlPathTracing
–SetResetToQ

Path Filters ➝ Common Fil-
ters ➝ Control Possible
False Paths ➝ Set/Reset to
Q Pin of Flip-flops

Synchronous
Not_Synchronous

No equivalent No equivalent

Help No equivalent Help ➝ Contents

XDelay Command
 Timing Analyzer

Keyboard Command
 Timing Analyzer
Menu Command
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Print No equivalent File ➝ Print

Printer No equivalent File ➝ Printer Setup

QueryBlk Query –Block Options ➝ Query ➝ Blocks

QueryGroup Query –Timegroup Options ➝ Query ➝ Time-
Group

QueryMargins No equivalent Options ➝ Set Delay Mar-
gins for I/O ➝ Defined
Margins

QueryNet Query –Net Options ➝ Query ➝ Nets

QuerySpec Query –Timespec Options ➝ Query ➝
TimeSpec

QueryTemplate No equivalent Analyze ➝ Show Settings

ReadMargins SetMargins Options ➝ Set Delay Mar-
gins for I/O

ReadTemplate No equivalent File ➝ Open Macro

Report Report Options ➝ Report Options

SaveMargins SetMargins Options ➝ Set Delay Mar-
gins for I/O

SaveTemplate No equivalent File ➝ Save Macro, File ➝
SaveAs Macro

SetMargins SetMargins Options ➝ Set Delay Mar-
gins for I/O

Speed Speed Options ➝ Change Speed
Grade

TimeGroup No equivalent No equivalent

TimeSpec No equivalent No equivalent

XDelay-TimeSpec PerformToTimeSpec Analyze ➝ Performance To
TimeSpecs

–BreakLoop BreakLogicLoop Path Filters ➝ Common Fil-
ters ➝ Break Logic Loops

XDelay Command
 Timing Analyzer

Keyboard Command
 Timing Analyzer
Menu Command
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–ClearOptions ResetFilters Path Filters➝ Reset Path Fil-
ters

–ClockInput SelectPathType
–PathsEndingAtFF

Path Filters ➝ Path Analysis
Filters ➝ Select Path Types
➝ Paths Ending At Clock
Pin of Flip-flop

–ClockToPad SelectPathType
–ClockToPad

Path Filters ➝ Path Analysis
Filters ➝ Select Path Types
➝ Clock To Pad

–ClockToSetup SelectPathType
–PadToSetup

Path Filters ➝ Path Analysis
Filters ➝ Select Path Types
➝ Pad To Setup

–Delaygreater DelayGreaterThan Options ➝ Report Options
➝ Report Delays Greater
Than

–Delayless DelayLessThan Options ➝ Report Options
➝ Report Delays Less Than

–DestClock DefineEndpts –ToRising or
–ToFalling

Path Filters ➝ Path Analysis
Filters ➝ Select Destinations
➝ Clocks

–FailedSpec SelectFailingTimespec Path Filters ➝ TimeSpec Fil-
ters ➝ ReportPathsFailing-
TimeSpec

–From DefineEndpts Path Filters ➝ Path Analysis
Filters ➝ Select Sources

–FromAll DefineEndpts –FromAll Path Filters ➝ Path Analysis
Filters ➝ Select Sources
➝ All

–FromFF DefineEndpts –FromFlip-
flop

Path Filters ➝ Path Analysis
Filters ➝ Select Sources
➝ Flip-Flops

–FromIOB DefineEndpts –FromIOBs Path Filters ➝ Path Analysis
Filters ➝ Select Sources
➝ IOBs

XDelay Command
 Timing Analyzer

Keyboard Command
 Timing Analyzer
Menu Command
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–IgnoreNet ExcludeNets Path Filters ➝ Common Fil-
ters ➝ Exclude Paths With
Nets

–Maxpaths MaxNoPaths Options ➝ Report Options
➝ Maximum Number of
Paths

–Netfilter No equivalent No equivalent

–NoBreakLoop BreakLogicLoop Path Filters ➝ Common Fil-
ters ➝ Break Logic Loops

–NoDestClock DefineEndpts –ToRising or
–ToFalling

Path Filters ➝ Path Analysis
Filters ➝ Select Destinations
➝ Clocks

–NoIgnoreNet IncludeNet Path Filters ➝ Common Fil-
ters ➝ Include Paths With
Nets

–Nonetfilter No equivalent No equivalent

–NoSourceClock DefineEndpts –FromRising
or –FromFalling

Path Filters ➝ Path Analysis
Filters ➝ Select Sources
➝ Clocks

–NoTimeGroups No equivalent No equivalent

–PadToPad SelectPathType –PadToPad Path Filters ➝ Path Analysis
Filters ➝ Select Path Types
➝ Pad To Pad

–PadToSetup SelectPathType
–PadToSetup

Path Filters ➝ Path Analysis
Filters ➝ Select Path Types
➝ Pad To Setup

–SelectSpec IgnoreToTimeSpec Path Filters ➝ TimeSpec Fil-
ters ➝ Ignore TimeSpecs

–Shortreport Report –Short Options ➝ Report Options
➝ Short Report

–Sort SortOn Options ➝ Report Options
➝ Sort By

XDelay Command
 Timing Analyzer

Keyboard Command
 Timing Analyzer
Menu Command
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–SourceClock DefineEndpts –FromRising
or –FromFalling

Path Filters ➝ Path Analysis
Filters ➝ Select Sources
➝ Clocks

–To DefineEndpts Path Filters ➝ Path Analysis
Filters ➝ Select Destinations

–ToAll DefineEndpts –ToAll Path Filters ➝ Path Analysis
Filters ➝ Select Destinations
➝ All

–ToFF DefineEndpts –ToFlipflop Path Filters ➝ Path Analysis
Filters ➝ Select Destinations
➝ Flip-Flops

–ToIOB DefineEndpts –ToIOBs Path Filters ➝ Path Analysis
Filters ➝ Select Destinations
➝ IOBs

–TSMaxpaths MaxNoPathsPerTimespec No equivalent

–Unspecified IncludeNoTimespec Path Filters ➝ TimeSpec Fil-
ters ➝ ReportPathsWithNo-
TimeSpec

–Widereport Report –Wide Options ➝ Report Options
➝ Wide Report

–WorstCase OnlyLongestPaths Options ➝ Report Options
➝ Report Only Longest
Paths Between Points

XDelay Command
 Timing Analyzer

Keyboard Command
 Timing Analyzer
Menu Command
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5-42

Alt key, 3-4
Analyze menu, 1-5, 5-2

Ascending Delay setting, 4-13, 5-31
asynchronous feedback paths, 2-11
asynchronous logic, 2-13
asynchronous Reset, 2-11, 4-31, 5-12
asynchronous Set, 2-11, 4-31, 5-12
Available Destinations option, 4-25, 5-37
Available Nets option, 4-33, 5-5
Available Nets/Blocks/TimeSpecs/
TimeGroups option, 5-29
Available Sources option, 4-24, 5-40

B
blocks, 4-31, 4-48, 5-12, 5-29
Blocks option, 4-48, 5-29
Break Logic Loops command, 2-11, 4-4, 4-
6, 4-8, 4-32, 5-4, 5-8, 5-13, 5-23, 5-24, 6-2
Break Logic Loops dialog box, 4-32, 5-5
BreakLogicLoop command, 6-2
BUFTs, 4-31, 5-11

C
Cancel option, 3-5
Cascade command, 5-6
Change Speed Grade command, 4-42, 4-46,
5-7, 5-43, 6-26
Change Speed Grade dialog box, 4-42
Check for Asynchronous Logic command,
2-13, 4-9, 5-8
Check for Asynchronous Logic report, 1-3,
4-9, 5-8, 6-3
CheckAsynch command, 6-3
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CLB RAM, 4-31, 5-11
CLBs, 4-14, 4-22, 4-24, 4-48, 5-29, 5-35, 5-38
clock input path, 1-3, 2-8, 4-27, 5-38, 6-22,
A-1
clock nets, 4-13, 5-31
Clock option, 4-44, 5-41
clock skew, 2-9, 2-13, A-2
Clock To Pad option, 4-27, 4-44, 5-38, 5-41
Clock To Setup option, 4-27, 5-38
clocks

listing all in design, 1-3, 4-9
clock-to-pad path, 1-3, 2-6, 4-27, 5-38, 6-22,
A-1
clock-to-setup path, 1-3, 2-2, 4-27, 5-38,
6-22, A-1
Close Report command, 4-18, 5-8
combinatorial logic, 1-1, 2-11, 5-4
common filters, 1-4, 5-8
Common Filters command, 4-19, 5-8
Console command, 3-4, 4-22, 4-34, 4-35,
4-42, 5-9
Console window, 1-3, 1-4, 3-3, 3-4, 4-22,
4-34, 4-42, 5-47

adding text, 4-34, 5-9
commands available, 6-1
creating macros, 4-35
deleting text, 4-34, 5-9
re-executing commands, 4-35, 5-9
search order, 5-10

Contents command, 3-10, 5-10
context-sensitive help, 1-5, 3-11
Control Possible False Paths command,
2-12, 4-4, 4-6, 4-8, 4-30, 5-8, 5-10, 5-13,
5-23, 5-24, 6-4
Control Possible False Paths dialog box,
4-30, 5-11
ControlPathTracing command, 6-4
Copy icon, 4-36, 5-45, 5-47
critical path, A-2

D
Data Input of CLB RAM setting, 4-31, 5-11

default printer, 4-14, 5-24, 5-25, 5-46
Default Printer option, 5-25
default Timing Analyzer settings, 4-45,
4-46, 5-42
Defined Margins option, 5-42
DefineEndpts command, 6-5
Delay Greater Than option, 4-48, 5-28
DelayGreaterThan command, 6-7
DelayLessThan command, 6-8
Descending Delay setting, 4-13, 4-46, 5-31,
5-42
design entry, 1-1
design flow, 1-1
Design Manager, 3-1, 6-26
Design Performance Summary icon, 4-5,
5-46
DesignSummary command, 6-9
Destination Block setting, 4-13, 5-31
Destination Clock Net setting, 4-13, 5-31
Destination Type option, 4-25, 5-36
destinations, 4-13, 4-24, 5-31, 5-35
DetailAnalysis command, 6-10
Detailed Analysis icon, 4-7
Detailed Path report, 1-3, 1-4, 4-7, 4-12,
4-20, 4-22, 4-26, 4-27, 4-30, 4-32, 5-4, 5-8,
5-10, 5-13, 5-14, 5-18, 5-35, 5-37, 5-38, 5-46,
6-10
Detailed Path Report command, 4-7, 5-13,
6-10
dialog boxes

closing, 3-7
common fields, 3-4
filters, 3-7
obtaining help, 3-11
selecting objects

keyboard, 3-6
mouse, 3-5

Direction option, 5-16
Directories option

Open Design/Report File dialog box,
4-2, 4-19, 5-21
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Open Macro File dialog box, 4-40, 4-41,
5-22
Save Macro As dialog box, 4-38, 4-39,
5-33
Save Report dialog box, 4-17, 5-35

Down setting, 4-11, 5-16
Drives option

Open Design/Report File dialog box,
4-2, 4-19, 5-21
Open Macro File dialog box, 4-40, 4-41,
5-22
Save Macro As dialog box, 4-38, 4-39,
5-33
Save Report dialog box, 4-17, 5-35

E
Edge option, 4-23, 4-25, 5-36, 5-39
error messages, 4-41
Escape key, 3-7
Exclude Paths With Nets command, 2-12,
4-4, 4-6, 4-8, 4-29, 5-8, 5-13, 5-23, 5-24, 6-10
Exclude Paths With Nets dialog box, 4-29,
5-14
Excluded Blocks option, 4-31, 5-12
Excluded Nets option, 4-28, 4-29, 5-14,
5-19
ExcludeNets command, 6-10
Exit command, 5-15, 6-11
exiting Timing Analyzer, 3-2
external delay see off-chip delay, 2-14

F
F1 key, 3-11, 5-10
false paths, 5-10
fanout, 4-47, 5-29
feedback loops, 2-11, 2-12, 2-13
File menu, 5-1
File Name option

Open Design/Report File dialog box,
4-19, 5-21
Open Macro File dialog box, 4-40, 4-41,
5-22

Save Macro As dialog box, 4-38, 4-39,
5-33, 5-34
Save Report dialog box, 4-17, 5-35

Filter for Available Destinations option, 4-
25, 5-36
Filter for Available Nets option, 4-33, 5-5
Filter for Available Sources option, 4-23,
5-39
Filter for Excluded Nets option, 4-28, 5-19
Filter for Included Nets option, 4-29, 5-14
Filter for Included/Excluded Blocks op-
tion, 4-31, 5-12
Filter for IOB Names option, 4-45, 5-41
Filter for Selected TimeSpecs option, 4-22,
5-17
Filter option, 4-48, 5-28
filters

characters allowed, 3-7
clearing, 3-7
finding patterns, 3-7
ranges, 3-7
specifying in dialog boxes, 3-7
wildcards, 3-7

filters see also path filters
Find command, 4-3, 4-10, 5-15
Find dialog box, 4-10, 5-15
Find Next option, 4-11, 5-16
Find What option, 4-11, 5-16
Force command, 4-42, 6-12
functional simulation, 1-1

G
global routing, 2-9

H
help, 1-5, 3-10, 3-11, 5-10
Help icon, 3-11, 5-47
Help menu, 1-5, 3-10, 5-4
Help option, 3-5, 3-11
hold time, A-2

I
Ignore TimeSpecs command, 4-4, 4-21,
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5-16, 5-24, 5-44, 6-12
Ignore TimeSpecs dialog box, 4-21, 5-17
Ignored TimeSpecs option, 4-22, 5-18
IgnoreTimespec command, 6-12
Include Paths With Nets command, 3-8,
4-4, 4-6, 4-8, 4-28, 5-8, 5-13, 5-18, 5-23,
5-24, 6-13
Include Paths With Nets dialog box, 3-8,
4-28, 5-18
Included Blocks option, 4-31, 5-12
Included Nets option, 4-28, 4-29, 5-14, 5-19
IncludeNet command, 6-13
IncludeNoTimespec command, 6-14
Input Pin to Output Pin of BUFT setting,
4-31, 5-12
inputs, 1-2
invoking Timing Analyzer, 3-1
IOBs, 4-22, 4-24, 4-31, 5-12, 5-35, 5-38, 5-41
IOBs option, 4-45, 5-42

K
keyboard, 3-3, 3-6, 4-43, 4-44

L
LCA file

checking for asynchronous logic, 1-3,
4-9, 5-8, 6-3
default speed grade, 4-46, 5-7, 5-43,
6-26
loading, 4-1, 5-20
output by PPR and APR, 1-2

List Files of Type option
Open Design/Report File dialog box,
4-2, 4-19, 5-21
Open Macro File dialog box, 4-40, 4-41,
5-22

M
macro icons, 4-35, 5-45
macros, 1-3, 1-4, 1-5, 3-4, 4-34

creating, 4-35
editing, 4-41, 5-22
running, 4-39, 5-32

saving, 4-41, 5-33, 5-34
edited, 4-38, 4-39
new, 4-37

suppressing messages, 4-41
mapping, 1-1
Margin option, 4-45, 5-41
Match Case option, 4-11, 5-16
Match Whole Word option, 4-11, 5-16
maximum clock frequencies, 1-3, 4-5
maximum clock time, 2-8
Maximum Number of Paths option, 4-12,
5-31
MaxNoPaths command, 6-14
MaxNoPathsPerTimespec command, 4-22,
6-15
menu bar, 3-3
menus, 1-3

commands available, 5-1
selecting commands, 3-3

minimum clock time, 2-8
minimum net delay, 4-48, 5-28
mouse, 3-3, 3-5, 4-43, 4-44
MS-Word, 4-17

N
negative clock skew, 2-9, 2-10
net binding table, 4-48
Nets option, 4-47, 5-29
Network option

Open Design/Report File dialog box,
5-21
Open Macro File dialog box, 5-22
Print Setup dialog box, 5-26
Save Report dialog box, 5-35

New Macro command, 4-35, 5-20, 5-47,
5-48
New Macro window, 4-35, 5-20, 5-47, 6-1

adding text, 4-37
deleting text, 4-37
pasting text, 4-36

Normal Report option, 4-14, 4-46, 5-32,
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5-42
Notepad, 4-17

O
off-chip delay, 2-14, 4-43, 5-40
OK option, 3-5
online help, 3-10, 5-10
OnlyLongestPaths command, 6-16
Open command, 4-1, 4-18, 5-20, 5-45, 6-17
Open Design File icon, 4-1, 5-45
Open Design/Report File dialog box, 4-1,
4-18, 5-20
Open Macro command, 4-39, 4-41, 5-22
Open Macro File dialog box, 4-39, 4-41,
5-22
OpenDesign command, 6-17
Options dialog box, 5-26
Options menu, 1-5, 5-3, 5-42
Options option, 5-26
Orientation option, 5-25
Output Pin to Input Pin of IOB setting,
4-31, 5-12
outputs, 1-2

P
Pad To Pad option, 4-27, 5-38
Pad To Setup option, 4-27, 4-44, 5-38, 5-41
pad-to-pad path, 1-3, 2-8, 4-27, 5-38, 6-22,
A-2
pad-to-setup path, 1-3, 2-7, 4-27, 5-38,
6-22, A-2
Paper option, 5-25
Paste icon, 4-36, 5-45, 5-47
path analysis filters, 1-4, 5-23
Path Analysis Filters command, 4-19, 5-23
path filters, 4-19

default settings, 4-45
destinations, 4-24, 5-35
Detailed Path report, 4-8, 4-22, 4-26, 4-
27, 4-30, 4-32, 5-4, 5-8, 5-10, 5-13, 5-14,
5-18, 5-37
false paths, 4-30, 5-10

logic loops, 4-32, 5-4
path analysis, 5-23
path types, 4-26, 5-37
paths with nets, 4-27, 5-13, 5-18
Performance Summary report, 4-6,
4-27, 4-30, 4-32, 5-4, 5-8, 5-10, 5-13,
5-18, 5-23, 5-35, 5-38
Performance To TimeSpecs report, 4-4,
4-27, 4-30, 4-32, 5-4, 5-8, 5-10, 5-13,
5-16, 5-18, 5-24
purpose, 4-3
resetting, 4-33, 5-32
sources, 4-22, 5-38
timing specifications, 4-20, 5-16, 5-32
types, 1-4

Path Filters menu, 1-5, 4-19, 5-2, 5-42
path types, 2-1, 5-37, 6-22

filtering, 4-26
Paths Ending At Clock Pin of Flip-flop
option, 4-27, 5-38
Paths Through option, 4-31, 5-11, 5-12
Performance, 1-3
Performance Summary command, 4-5,
5-23, 5-46, 6-9
Performance Summary report, 1-3, 1-4,
1-5, 4-5, 4-20, 4-26, 4-27, 4-30, 4-32, 5-4,
5-8, 5-10, 5-13, 5-18, 5-23, 5-35, 5-37, 5-38,
5-46, 6-9
Performance To TimeSpec icon, 4-3
Performance To TimeSpecs command,
2-13, 4-3, 5-23, 5-46, 6-17
Performance To TimeSpecs report, 1-3, 1-4,
2-13, 4-3, 4-20, 4-21, 4-22, 4-27, 4-30, 4-32,
5-4, 5-8, 5-10, 5-13, 5-18, 5-23, 5-32, 5-46,
6-17
PerformToTimespec command, 6-17
placing and routing, 1-1
positive clock skew, 2-9, 2-11
PPR, 1-2, 2-12, 4-21
Print command, 4-14, 5-24, 5-46
Print dialog box, 4-14, 5-24
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Print Report icon, 4-14
Print Setup dialog box, 4-15, 5-25
Printer Setup command, 4-15, 5-25
Printers - Network Connections dialog
box, 5-21, 5-22, 5-26, 5-27, 5-34, 5-35
Profile menu, B-1

Q
Query command, 2-14, 4-47, 5-27, 6-18
Query dialog box, 4-47, 5-27
Query option, 5-29

R
RAM, 2-2, 2-7, 2-8, 4-30, 4-31, 5-10, 5-11,
A-1, A-2
Read Only option, 5-22
Remove All option

Control Possible False paths dialog box,
5-13
Exclude Paths With Nets dialog box,
5-15
Ignore TimeSpecs dialog box, 5-18
Include Paths With Nets dialog box,
5-20
Query dialog box, 5-30
Select Destinations dialog box, 5-37
Selected Sources dialog box, 5-40
Set Delay Margins for I/O dialog box,
5-42

Remove option
Break Logic Loops dialog box, 5-6
Control Possible False Paths dialog box,
5-13
Exclude Paths With Nets dialog box
5-15

Ignore TimeSpecs dialog box, 5-18
Include Paths With Nets dialog box,
5-20
Query dialog box, 5-30
Select Destinations dialog box, 5-37
Selected Sources dialog box, 5-40
Set Delay Margins for I/O dialog box,

5-42
Report command, 6-19
Report Delays Greater Than option, 4-13,
5-31
Report Delays Less Than option, 4-13, 5-31
Report Only Longest Paths Between Points
option, 4-14, 4-46, 5-31, 5-43
Report Options command, 4-11, 5-30, 6-8,
6-14, 6-16, 6-19, 6-25
Report Options dialog box, 4-11, 4-46,
5-30, 5-43
Report Paths Failing TimeSpec command,
4-4, 4-20, 4-46, 5-24, 5-32, 5-43, 5-44, 6-21
Report Paths With No TimeSpec com-
mand, 4-4, 4-21, 4-46, 5-24, 5-32, 5-43, 5-44,
6-14
reports

closing, 4-18
creating, 4-3
customizing, 4-11
opening saved, 4-18
printing, 4-14
saving, 4-16, 5-34
searching for text, 4-10

Reset Path Filters command, 4-34, 5-32
6-20

ResetFilters command, 6-20
Run, 5-48
Run Macro command, 4-40, 4-42, 5-32,
5-48, 6-21
Run Macro icon, 4-40, 5-45, 5-48
RunMacro command, 6-21

S
Save As Macro command, 4-39, 5-33
Save File as Type option

Save Macro As dialog box, 4-39, 5-33
Save Report dialog box, 4-17, 5-35

Save icon, 5-45
Save Macro As dialog box, 4-37, 5-33, 5-34
Save Macro command, 4-37, 4-38, 4-41,
5-33, 5-34
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Save Report command, 4-16, 5-34, 5-45
Save Report dialog box, 4-16, 5-15, 5-34
Save Report icon, 4-16
Search for Help On command, 3-11, 5-35
Select Destinations command, 4-6, 4-8,
4-24, 5-13, 5-23, 5-35, 6-5
Select Destinations dialog box, 4-24, 5-35
Select Path Types command, 4-6, 4-8, 4-26,
5-13, 5-23, 5-37, 6-22
Select Path Types dialog box, 4-26, 5-37
Select Sources command, 4-6, 4-8, 4-23,
5-13, 5-23, 5-38, 6-5
Select Sources dialog box, 4-23, 5-38
Selected Destinations option, 4-25, 5-37
Selected Nets option, 4-33, 5-5
Selected Nets/Blocks/TimeSpecs/Time-
Groups option, 5-29
Selected Sources option, 4-23, 4-24, 5-40
Selected TimeSpecs option, 4-22, 5-17
SelectFailingTimespec command, 6-21
SelectPathType command, 6-22
Set Delay Margins for I/O command, 2-14,
4-43, 5-40, 6-23
Set Delay Margins for I/O dialog box, 4-43,
5-40
Set/Reset to Q Pin of Flip-flops setting,
4-31, 5-12
SetMargins command, 6-23
setup and hold checks, 1-1
Setup option, 5-25
setup time, 2-7, A-2, A-3
Short Report option, 4-14, 5-32
Show Clocks command, 4-9, 5-42, 6-24
Show Clocks report, 1-3, 4-9, 5-42
Show Command and Its Status box, 4-35,
5-9, 5-10
Show Settings command, 4-33, 4-45, 5-32,
5-42
Show Settings window, 4-45
ShowClockNets command, 6-24
Size option, 5-25

Sort By option, 4-12, 4-13, 5-31
SortOn command, 6-25
Source Block setting, 4-13, 5-31
Source Clock Net setting, 4-13, 5-31
Source option, 5-25
Source Type option, 4-23, 5-39
sources, 4-13, 4-22, 5-31, 5-38
Specific Printer option, 5-25
Speed command, 6-26
speed grade, 4-42, 4-46, 5-7, 5-43, 6-26
static timing analysis, 1-1, A-3
status bar, 3-3, 5-43
Status Bar command, 3-3, 5-43
synchronous paths see path types
synchronous Reset, 4-27

T
Tile command, 5-43
TimeGroup option, 4-48, 5-29
TimeSpec Filters command, 4-19, 5-44
TimeSpec option, 4-48, 5-29
Timing Analyzer window, 3-2
timing groups, 4-48, 5-29
timing simulation, 1-1
timing specification filters, 1-4, 5-44
timing specifications, 2-12, 4-3, 6-12, 6-17,
6-21, A-3

automatic assignment by PPR, 4-21
filtering, 4-20, 5-44
ignoring, 4-21, 5-16
limiting number of paths reported per,
4-22
obtaining information about, 4-48, 5-29
reporting paths that do not meet, 4-20,
4-46, 5-32, 5-43
reporting paths with no, 4-20, 4-46,
5-32, 5-43

toolbar, 1-3
displaying, 5-45
icons, 3-4, 5-45
location on Timing Analyzer window,
3-3
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Toolbar command, 3-3, 5-45
Tristate Pin to Input Pin of IOB setting,
4-31, 5-12
Tristate to Output Pin of BUFT setting,
4-31, 5-11
tutorial, 1-5, 3-11, 5-45
Tutorial command, 1-4, 1-5, 3-11, 5-45

U
Up setting, 4-11, 5-16

V
View menu, 5-3
Viewlogic tutorial on Timing Analyzer, 1-5

W
Wide Report option, 4-14, 5-32
wildcards, 3-7

Window menu, 5-3
Windows for Workgroups, 5-21, 5-23,
5-26, 5-34, 5-35

Windows Program Manager, 3-1
worst-case path delay, 1-3, 4-5, 4-7
Write Enable of CLB RAM setting, 4-31,
5-11

X
XACT-Performance, 1-4, 4-46, 6-17, 6-21,
A-3
XDelay, 1-2

commands, B-1
Profile menu, B-1

Xilinx report files see XRP files
XRP files, 1-2, 4-17, 5-20
XTM files, 1-2, 4-38, 4-39, 4-41, 5-22, 5-33
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